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Important Safety Instructions 
1. Follow all warnings and instructions marked on the product.
2. Unplug this product from the wall outlet before cleaning. Do not use liquid 

cleaners or aerosol cleaners. Use a damp cloth for cleaning.
3. Do not use this product near any liquids.
4. Do not place this product on an unstable surface. The product may fall, causing 

serious damage to the product.
5. Do not drop the product.
6. Do not block the slots and openings on the back or bottom side of the chassis; to 

ensure proper ventilation and reliable operation of the product and to protect it 
from overheating, these openings must not be blocked or covered. 

7. Operate this product only from the type of power indicated on the marking label. If 
you are not sure of the type of power available, consult your dealer or local power 
company.

8. Do not allow anything to rest on the power cord. Do not locate this product where 
persons will walk on the cord.

9. If an extension cord is used with this product, make sure that the total ampere 
rating of the equipment plugged into the extension cord does not exceed the 
extension cord ampere rating. Also, make sure that the total rating of all products 
plugged into the wall outlet does not exceed the fuse rating.

10.Never push objects of any kind into this product through the chassis slots as they 
may touch dangerous voltage points or short out parts that could result in a fire or 
electric shock.

11.Unplug this product from the wall outlet and refer servicing to qualified service 
personnel under the following conditions:
a When the power cord or plug is damaged or frayed.

b If liquid has been spilled on the product.

c If the product has been exposed to rain or water.

d If the product does not operate normally when the operating instructions are followed. Adjust 
only those controls that are covered by the operating instructions since improper adjustment 
may result in damage and require extensive work by a qualified technician to  the product to 
normal condition.

e If the product has been dropped or the chassis has been damaged.

f If the product exhibits a distinct change in performance, indicating a need for service.

12. In accordance with workstation regulation standards, do not place this device in 
the visual field of the user due to the glossy front of the case.

WARNING! The WD ShareSpace uses a lithium battery, type CR2032. There is 
danger of an explosion if the battery is incorrectly replaced. Replace only with 
the same or equivalent battery type recommended by the manufacturer. 
Dispose of used batteries according to the manufacturer’s instructions. 
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WD Service and Support
Should you encounter any problem, please give us an opportunity to address it 
before returning this product. Most technical support questions can be answered 
through our knowledge base or e-mail support service at support.wdc.com. If the 
answer is not available or, if you prefer, please contact WD at the best telephone 
number shown below.

Your product includes 30 days of free telephone support during the warranty period. 
This 30-day period starts on the date of your first telephone contact with WD 
technical support. E-mail support is free for the entire warranty period and our 
extensive knowledge base is available 24/7. To help us keep you informed of new 
features and services, remember to register your product online at
 https://www.wdc.com/register.

Accessing Online Support

Visit our product support website at support.wdc.com and choose from these topics:
• Downloads - Download drivers, software, and updates for your WD product.
• Registration - Register your WD product to get the latest updates and special 

offers.
• Warranty & RMA Services - Get Warranty, Product Replacement (RMA), RMA 

Status, and Data Recovery Information.
• Knowledge Base - Search by keyword, phrase, or answer ID. 
• Installation - Get online installation help for your WD product or software.

Contacting WD Technical Support 

When contacting WD for support, have your WD product serial number, system 
hardware, and system software versions available.
North America Asia Pacific

English 800.ASK.4WDC Australia 1 800 42 9861
(800.275.4932) China 800 820 6682/+65 62430496 

Spanish 800.832.4778 Hong Kong +800 6008 6008
India 1 800 11 9393 (MNTL)/1 800 200 5789 (Reliance)

011 26384700 (Pilot Line)

Europe (toll free)*
00800 ASK4 
WDEU

Indonesia +803 852 9439 

(00800 
27549338)

Japan 00 531 650442

Korea +82-2-2093-1007
Europe +31 880062100 Malaysia +800 6008 6008/1 800 88 1908/+65 62430496 
Middle East +31 880062100 Philippines 1 800 1441 0159

Africa
+31 880062100 Singapore +800 6008 6008/+800 608 6008/+65 

62430496 
Taiwan +800 6008 6008/+65 62430496 

* Toll free number available in the following countries: Austria, Belgium, Denmark, France, Germany, Ireland, 
Italy, Netherlands, Norway, Spain, Sweden, Switzerland, United Kingdom. 
WD SERVICE AND SUPPORT - 1
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Registering Your WD Product

Your WD product includes 30 days of free technical support during the applicable 
warranty period for your product. The 30-day period commences on the date of your 
first telephone contact with WD technical support. Register online at 
register.wdc.com.
WD SERVICE AND SUPPORT - 2
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1
 Overview
Congratulations on your purchase of WD ShareSpace™, a high-speed network attached 
storage system with a space-saving footprint. This system is equipped with WD drives using 
WD GreenPower™ technology for efficient cooling and power saving. The multi-level RAID 
support and high-speed interfaces deliver high performance for small offices or home users 
and is ideal for backing up and sharing files over the Internet.

This user manual provides step-by-step installation instructions and other important 
information regarding your WD product. For the latest WD product information and news, 
visit our website at www.westerndigital.com.

Format and Configuration

WD ShareSpace is preformatted for maximum reliability as a RAID 5 volume (for four-drive 
systems) or for maximum capacity as a single large, spanned volume (for two-drive systems). 
In RAID 5, one quarter of the capacity is used to store parity information needed to restore 
data in the event of a drive failure. In a spanned volume, the capacity is equal to the total of all 
drives in the volume. To access the maximum capacity using four drives on this device, the 
RAID configuration must be reset to either RAID 0 or Span. For more information on how to 
set up RAID, see “Manage RAID” on page 114.

Specifications

Ethernet High performance (10/100/1000) Gigabit Ethernet connection

Internal hard drives Up to four WD 3.5-inch SATA hard drives 

External USB storage 
file systems supported

NTFS, FAT/FAT32

Supported protocols HTTP, HTTPS, CIFS/SMB, NFS, FTP

I/O ports • Three USB 2.0 ports (one front for file backup, two rear for USB 
device expansion)

• Ethernet (RJ-45) port

Supported clients • Windows® 2000/XP/Vista (latest service packs required)/Server 
2003

• Mac OS® X Tiger® or Leopard®

Physical dimensions • Width: 6.30 in (160.1 mm)
• Height: 7.73 in (196.2 mm)
• Length: 7.84 in (199.18mm)
• Weight: 5.28 lb (2.4 kg)

Power consumption • Input voltage: 100V to 240V AC
• Input frequency: 50 to 60 Hz

Environmental • Operating temperature: 5 to 35 °C (41 to 95 °F)
• Non-operating temperature: -20 to 65°C (-4 to 149 °F)
OVERVIEW - 3
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Kit Contents

Accessories

Visit shopwd.com (U.S. only) to view additional accessories like cables, power 
supplies, additional hard drives, and drive mounting rails for this product. Outside the 
U.S., visit support.wdc.com.

Ethernet cable Installation CD with 
application software 
and user manual

Quick Install Guide

WD ShareSpace with four 
or two drives

Drive mounting rails 
(only included with two-drive systems)

AC adapter 
and power cords
OVERVIEW - 4
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System Requirements

For optimum performance, the following system and network requirements are 
recommended. Compatibility may vary depending on user’s hardware configuration 
and operating system.

Important: For highest performance and reliability, it is recommended that 
you install the latest updates and service pack (SP). For Macintosh, go to 
the Apple menu and select Software Update. For Windows, go to the 
Start menu and select Windows Update.

Client computer

• Ethernet connection (network adapter)
• Operating system 

• Windows 2000/XP/Vista/Server 2003

• Mac OS X Tiger or Leopard

• Web browser (Internet Explorer 6.0 SP1 and later on Windows platforms 
supported by this product, Safari 2.0 and later on Mac platforms supported by 
this product, Firefox 2.0 and later on supported Windows and Mac platforms)

• Adobe Flash ActiveX 9 or higher (required for WD Discovery™)
Local network

• Router/switch (Gigabit required to maximize performance)
Wide Area Network

• Broadband Internet connection required for remote access using MioNet

Pre-installation

Before unpacking and installing the system, select a suitable site for the system for 
maximum efficiency. Place the device in a site that is:

• Near a grounded power outlet
• Clean and dust free
• On a stable surface free from vibration
• Well-ventilated and away from sources of heat
• Secluded from electromagnetic fields from electrical devices such as air 

conditioners, radio, TV transmitters. 
OVERVIEW - 5
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Recording Your WD Product Information

In the following table, write the serial number and model number of your new WD 
product found on the label on the bottom of the device. Also, write the purchase date 
and other notes such as your operating system and version. This information is 
necessary for setup and technical support. 

System View

Power Button

Important: The device powers on automatically upon initial connection to 
power, which may take up to three minutes. During this time, do not press 
the power button.

The power button turns the device on or off. To turn on the device, press the power 
button and hold down until the LED flashes once, then release. The LED remains off 
(up to 30 seconds) as the device powers up. Holding the button down for four 
seconds powers off the device.

Serial Number:

Model Number:

Purchase Date:

System and Software Notes:

1 Power button 5 Power port

2 LED indicators 6 Reset button

3 USB backup button 7 Ethernet port

4 USB port 1 (Auto-backup) 8 USB ports 2 and 3

9 Kensington® security slot
OVERVIEW - 6
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LED Indicators

The LED (light-emitting diode) indicators on the device provide information about the 
status of the system, its hard drives, and network connection. The LEDs on the 
system indicate the following:

Indicator 
and icon

Color State Description

Power Green Steady System is powered up (connected to the power supply and turned on) and 
ready for use.

Off System is not powered on

Flashing • System is booting
• System is restoring to factory default
• System is configuring RAID on the hard drive(s)
• System is configuring RAID 0, Span, or RAID 5 on a volume
• User volume is not available

Hard drives Green Random 
flashing

Hard drive is in use

Steady • Hard drive is ready for use
• Hard drive is installed

Amber Steady • Hard drive error

Green/
Amber

Flashing • System detects a foreign hard drive with pre-existing data

Green/
Amber

Off • Hard drive is not present
• Hard drive is not properly installed

Ethernet 
(front)

Green On Network link is detected

Off No network connection

Flashing Transmit or receive activity

System 
identification
/error

Blue On System identification is active

Off System identification is disabled

Red Flashing Critical condition

USB backup Green Steady • A USB storage device is connected to the front USB port
• RAID system is rebuilding
• Restoring configuration settings
• System initialize operation in progress

Flashing • One flash per second—system is formatting a USB drive
• One flash per second (backup)—USB device to WD ShareSpace
• Two flashes per second (backup)—WD ShareSpace to USB device

Off • System initialize operation completed

Ethernet 
(rear)

Orange Flashing • Network is connecting 
• Link activity

Green Steady Network is connected

Flashing Network connection is active
OVERVIEW - 7



WD SHARESPACE
USER MANUAL
USB Backup Button

The USB backup button allows you to back up data from a USB drive to the device or 
from the device to a USB drive. The USB backup feature only works on the front USB 
port (port 1). See “USB Auto Backup Feature” on page 60 for detailed instructions. 

Ports 

Reset Button

The reset button restores configuration settings such as the machine name, network 
mode/IP address, and admin password to default factory settings without erasing 
shared folders and volumes. For more information on how to reset the system, see 
“Resetting the WD ShareSpace” on page 151.

Kensington Security Slot

For drive security, the device is equipped with a security slot, which supports a 
standard Kensington security cable. For more information on the Kensington security 
slot and available products, visit www.kensington.com.

Component Icon Description

USB port 1 Connects to a USB drive. 
Note: This port has an auto-backup feature that 
makes it possible to automatically create backups of 
digital files from a USB drive to the device and vice-
versa. 

USB ports 2 and 3 Connects to a USB drive. 

Ethernet port Connects the device to a local network.

Reset button Restores the admin user name and password for the 
device.

Power port Connects the device to an AC adapter and the power 
outlet.
OVERVIEW - 8

www.kensington.com
www.kensington.com


WD SHARESPACE
USER MANUAL

2
 WD ShareSpace Basic Setup
Step 1: Connect WD ShareSpace to the Network

Follow the steps below to connect the WD ShareSpace to a small 
home/office network. 

1. Connect one end of the Ethernet cable into the Ethernet port located on the back 
of the device.

2. Connect the other end of the Ethernet cable directly into a router or network 
switch port.

3. Connect the end of the adapter into the DC power supply socket located on the 
back of the device.

4. Plug the AC adapter into a power outlet. The unit powers up automatically after 
approximately 30 seconds indicated by a steady green LED illuminated on the 
power button.

Important: Wait for the WD ShareSpace to finish powering up (approximately three 
minutes) before configuring the device.

To power down the device, press and hold down the power button down for at 
least four seconds. 
WD SHARESPACE BASIC SETUP - 9
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Step 2: Access WD ShareSpace on the Network

You can easily find your WD ShareSpace on the local area network (LAN). Follow the 
appropriate procedure below:

• Windows 2000/XP/Vista on page 10
• Rally (Windows Vista) on page 11
• Macintosh Leopard on page 20
• Macintosh Tiger on page 24

WD Discovery

The WD Discovery application on the included CD should be installed on every PC 
connected to the LAN from which you intend to access your WD ShareSpace.

Windows 2000/XP/Vista/Server 2003

1. Turn on your computer and wait for the operating system to load.

2. Insert the software-installing CD into the CD or DVD ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start 
and then Computer (Windows Vista) or My Computer (Windows 2000/XP). Right-click the CD/
DVD drive, click Open, and double-click Setup.exe.

3. Windows Vista: Click Run setup.exe, then click Allow.

4. Click Accept in the Terms of Agreement screen.
WD SHARESPACE BASIC SETUP - 10
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5. If you have connected the WD ShareSpace properly as shown in the Connect 
screen, click Next.

6. The Application Installer screen opens, displaying a list of options. Click WD 
Discovery Tool. Once the WD Discovery Tool installation is complete, it will 
automatically launch and the WD Discovery icon will display on your desktop.

7. The WD Discovery screen appears. Click WDShareSpace in the Network 
Drives Found list and click Configure.

8. The login page appears. Continue device setup by following the instructions for 
“Setting Up the Device” on page 71.

Other Access Methods

Rally (Windows Vista)

Rally is a technology that comes with Vista and offers an alternative for easy setup 
and mapping of the WD ShareSpace without using WD Discovery. 
WD SHARESPACE BASIC SETUP - 11
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To open the WD ShareSpace shares:

1. Right-click WDShareSpace and click Open. The Public, Private, and Download 
shares (default shares) display.

To view the WD ShareSpace web page:

1. Right-click WDShareSpace and click View device webpage. The login page 
appears. (See “Accessing WD ShareSpace’s Network Storage Manager” on 
page 74 for information on logging in.)

To create a shortcut to the WD ShareSpace:

1. Right-click WDShareSpace and click Create Shortcut. 

Note: Create a WD ShareSpace icon on your desktop by installing a driver. Insert the WD 
ShareSpace CD and right-click the WD ShareSpace icon in My Computer. Click Open > 
WD_Windows >Tools > WD_Rally_Drivers > PnPxNas-4NC. Right-click PnPxNas-4NC.in and 
click Install.

To view the properties of the WD ShareSpace:

1. Right-click WDShareSpace and click Properties.

To uninstall:

1. Right-click WDShareSpace and click Uninstall.
WD SHARESPACE BASIC SETUP - 12
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Macintosh Leopard

1. Turn on your computer and wait for the operating system to load.

2. In Finder, double-click WDShareSpace in the Shared list (if necessary, click All 
then double-click WDShareSpace).

3. If the connection fails, click Connect As on the WDShareSpace screen that 
appears.

4. On the login screen, type “admin” in both the Name and Password fields and 
make sure the Remember this password in my keychain check box is 
selected. Click Connect.

5. Double-click the Public icon to display the subfolders: Shared Music, Shared 
Pictures, and Shared Videos.

Note: Configuration is a read-only share containing only a Help file and the login page.
WD SHARESPACE BASIC SETUP - 13
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You can now drag and drop files into the shared folders using Finder.

6. To make the shared drive icon permanent on your desktop, create an alias:

Note: Before creating an alias, click Finder>Preferences and make sure Connected Servers is 
checked.

(a) Double-click the item you want to alias (e.g., the Public share icon), and click one of the 
subfolders. 

(b) Click File>Make Alias. 

The Public share icon displays on your desktop.

Macintosh Tiger

1. Turn on your computer and wait for the operating system to load.

2. On the menu bar, click Go>Connect to Server. 

3. Click Browse and double-click the WD ShareSpace.

4. On the Connect to Server screen, click Connect.
WD SHARESPACE BASIC SETUP - 14
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5. Type “admin” in both the Name and Password fields and select the Remember 
this password in my keychain checkbox. Click OK.

6. Double-click WDShareSpace.

7. In the left pane, under Shared, double-click Public to display the Public 
subfolders (Shared Music, Shared Pictures, and Shared Videos). 

You can now drag and drop files into the shared folders using Finder.

8. The share appears as a shared drive icon on the desktop depending on your 
preferences. To make the shared drive icon permanent on your desktop, create an 
alias:

Note: Before creating an alias, click Finder>Preferences and make sure Connected Servers is 
checked.

(a) Click the item you want to alias (for example, Public).

(b) While holding down the Ctrl or Cmd key and the Option key simultaneously, drag the item to 
where you want the alias to appear. The alias appears at the new location.
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Congratulations!

Your WD ShareSpace is now ready for use and is accessible as a drive letter in My 
Computer (Windows) or a shared drive icon on the desktop (Macintosh). You can 
now drag and drop files into your WD ShareSpace and move files from your 
WD ShareSpace to any computer in your network that has been set up according to 
the instructions above.

This user manual contains information and instructions for all other basic and 
advanced WD ShareSpace device management functions, including:

• Backing up your computer (see “Backing Up Computers on a Network” on page 
18)

• Accessing WD ShareSpace from a remote computer (see “MioNet Remote 
Access” on page 41)

• Playing and streaming media (see “How to Play/Stream Video, Music & Photos” 
on page 51)

• Using iTunes service (see “Using iTunes with WD ShareSpace” on page 58)
• Connecting a USB drive for additional storage and file exchange (see “External 

USB Drive Sharing & Backup” on page 60.)
• Configuring the WD ShareSpace device and network settings, set e-mail or 

window alerts, change the administrator password, perform firmware upgrades, 
restore system to factory defaults, configure RAID, manage file share preferences, 
set the backup destination folder, set disk quotas, set a share folder for users, 
add, modify, and delete users and groups, and change all user and group 
permissions (read/write, read only, no access) to shares/folders and USB storage 
devices (see “Network Storage Manager: Basics” on page 69 and “Network 
Storage Manager: Advanced” on page 87).
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WD ShareSpace File Storage

You can access and store content on WD ShareSpace via network shares. Shares 
are folders that can be used to organize and store files on your 
WD ShareSpace. Shares can be shared with everyone (public) or with selected 
users on your network (private). 

The device comes preconfigured with three shares: 

• Public—created automatically after initial setup 
• Shared Music - folder for storing music files you want to share with other users. 

• Shared Pictures - folder for storing image files you want to share with other users. 

• Shared Videos - for storing video files you want to share with other users. 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Service. For more information on 
how to use Twonky media, see “How to Play/Stream Video, Music & 
Photos” on page 51. For more information on how to use the iTunes 
service, see “Using iTunes with WD ShareSpace” on page 58.

• Download—for saving files using Downloader (see “Scheduled Downloads” on 
page 141).

• Configuration—this is a read-only share containing only a Help file and the login 
page. It is not meant for sharing or storing data and should not be modified.
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3
 Backing Up Computers on a Network

WD Anywhere Backup Overview

WD Anywhere Backup software is a quick and easy and secure way to back up all 
the computers in your network. Your WD ShareSpace Installation CD comes with five 
licenses for WD Anywhere Backup—each one enabling you to activate a single PC 
or Mac for continuous backup. Select the files you want to back up, and then set the 
WD ShareSpace and forget it; every time you save a change it’s automatically 
backed up.

Installing WD Anywhere Backup

Important Notes for Installing WD Anywhere Backup

Install on Each Computer: You must use the Installation CD to install WD 
Anywhere Backup on each computer in your network.

Install on the LAN and Power On First: You must have your WD ShareSpace 
connected to your local area network and powered on before you install WD 
Anywhere Backup software. This will ensure that the WD Anywhere Backup 
recognizes your WD ShareSpace and will install as the full software version instead 
of the 30 Day trial version.

Laptop Users: When you are traveling, your laptop files will not be backed up. If you 
want to have your files automatically backed up upon reconnection with your home 
network, you must set your passwords on your laptop and your WD ShareSpace to 
be the same. Otherwise, you will have to log in to your WD ShareSpace every time 
you reconnect to your home network before WD Anywhere Backup will begin to back 
up your files.

Windows

1. Turn on your computer and wait for the operating system to load.

2. Insert the software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start 
and then Computer (Windows Vista) or My Computer (Windows 2000/XP). Right-click the CD/
DVD drive, click Open, and double-click Setup.exe.

3. Windows Vista: Click Run setup.exe and then click Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen, click 
Next.

6. Click WD Anywhere Backup. 
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Note: It may take a minute or two for the next screen to display.

7. Select your preferred language from the list and click OK.

8. Close all other open applications, and then click Next to continue.

9. If you accept the terms of the agreement, click I Agree to continue.

10.After WD Anywhere Backup has finished installing, click Finish to begin using 
WD Anywhere Backup. 
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The WD Anywhere Backup Configuration screen appears. Continue with “One-
Click Backup” on page 24.

Note: The WD Anywhere Backup icon now appears on your desktop, and WD Anywhere Backup 
is listed in Program Files. 

Macintosh Leopard or Tiger

1. Turn on your computer and wait for the operating system to load.

2. Double-click the WD ShareSpace icon on the desktop.
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3. Double-click WD_Anywhere_Backup.dmg.

4. On the WD Anywhere Backup screen, click the WD Anywhere Backup icon. 

5. On the verification dialog box, click Continue. 

6. On the first screen of the Install WD Anywhere Backup wizard, click Continue.
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7. On the Software License Agreement screen, click Continue.

8. To accept the software license agreement, click Agree.

9. Click Install.

10.Enter your Mac user name and password.

11.When a screen verifying successful installation appears, click Close.
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12.  Now you can begin backing up your data. Click + > Create Backup Plan.
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Configuring WD Anywhere Backup 

One-Click Backup

WD Anywhere Backup allows you to back up all your important data, such as 
documents, photos, music and videos, on your computer’s hard drive with the click of 
a button. This feature backs up your data to the WD ShareSpace so you can restore 
your data in the event that your computer’s hard drive crashes.

The first time you install WD Anywhere Backup, the WD Anywhere Backup 
Configuration screen appears. 

Note: The screen below only appears when you have WD ShareSpace attached to your computer’s 
local area network.

This screen offers two options:

Automatic Backup: The main option is to have the WD ShareSpace automatically 
and continuously back up your files, providing assurance that your files can always be 
restored.

What it backs up

One click backup backs up the main computer‘s c: drive on a PC. 

What it does not back up

One click backup does not include files on the A: drive, application files such as 
MS Word or Adobe Acrobat, temporary and log files, virtual hard disk files, or files 
in the system folders. 

Customized Backup: The other option is to customize your backup to back up only 
selected types of files, for example, only photos or videos, or other drives. 

Backup All Files

Link to Customize Backup
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To start an automatic and complete backup of your computer’s hard drive:

1. Click Back Up All of My Files.

2. A message explains that initial backup will use moderate resources on your 
computer. To pause the backup, click Pause until System Idle. To keep the 
backup running in the background, click Continue. 

Note: If you do not want these messages to display in the future, click Do not show Configuration 
Wizard at startup.

3. A registration screen appears. If desired, enter the optional registration 
information. Click Continue.
BACKING UP COMPUTERS ON A NETWORK - 25



WD SHARESPACE
USER MANUAL
The WD Anywhere Backup screen displays the progress of the backup.

When the backup has finished, a backup complete message appears.

4. To create another backup, click Create and continue with step 3 in “Creating a 
Customized Backup Plan” on page 27. If not creating another backup, close the 
screen. The WD Anywhere Backup icon appears in the system tray.

To customize a backup plan:

1. Click the Customize My Backup link at the bottom right of the WD Anywhere 
Backup Configuration screen. The Welcome to the WD Anywhere Backup 
Wizard screen appears. 

2. Continue with step 3 in “Creating a Customized Backup Plan” on page 27.
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Creating a Customized Backup Plan

Creating and customizing a backup plan gives the advanced user complete control 
over which files are backed up.

1. If WD Anywhere Backup is not already running, click the WD Anywhere Backup 
icon on the desktop.

2. Click Create. (If the screen shows no backup plans, none have been created.)

3. The welcome screen for customizing your backup appears. Click Next.
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4. Click Network Places and locate your WD ShareSpace on your local area 
network. Click Next.

The Select Items to Back Up screen displays.

You have two options:

To select all items, see “Selecting all items from SmartPicks” on page 29.

To select specific items, see “Selecting your own backup items” on page 31.
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Selecting all items from SmartPicks

1. Click the All Items from SmartPicks button. The SmartPicks screen displays, 
listing common file types that you can back up. 

2. Select each file type you want to back up. You can also click Select None to 
clear all selections, or click Select All to select all of the items.  

3. To add more items, click the Add Backup Items button. The Local Folders tab 
displays. Select additional folders and click Select.
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4. To exclude more items from your plan:
(a) Click the Show Advanced Items button.

(b) Click the Add Exclusion button.

(c) Select items to exclude from the backup plan, or click the Select Folder to Exclude and 
select any folders from the plan. Click the Select button.

5. On the Items Selected for Backup screen, click Next button. 

6. Continue with “Completing the Backup Plan” on page 32.
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Selecting your own backup items

1. Click the My Own Backup Items button. The SmartPicks screen appears, 
listing default file locations you can back up. 

2. You have two options:
(a) On the SmartPicks tab, select each item you want to back up. You can also click Select 

None to clear all selections, or click Select All to select all of the items. When finished, click 
Next. 

(b) On the Local Folders tab, select each folder you want to back up and click Select.
BACKING UP COMPUTERS ON A NETWORK - 31



WD SHARESPACE
USER MANUAL
3. On the Items Selected for Backup screen, you can add more items or use 
advanced items as described in “Selecting all items from SmartPicks” on page 
29.

4. On the Items Selected for Backup screen, click Next button. 

5. Continue with “Completing the Backup Plan” on page 32.

Completing the Backup Plan

1. Name your backup plan and click Next. You can create additional backup plans 
by repeating the steps above. 
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2. A confirmation screen appears. Click Done.

3. A message explains that initial backup will use moderate resources on your 
computer. To pause the backup, click Pause until System Idle. 

4. To keep the backup running in the background, click Continue.

The WD Anywhere Backup screen displays the progress of the backup.
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When the backup finishes, the Backup Complete screen appears.

Alternatively, close the screen, click the WD Anywhere Backup icon, and select 
Show backup status.

As files are backed up, a small notification window appears.
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Restoring a Backup Plan

You can restore the files in your backup plan to a specified location in the event that 
you accidentally delete a file, want to compare file versions, or have lost all data due 
to a hard drive crash on your computer.

1. Click View and Restore. 

2. Click a backup plan in the Select a Plan list, or to search for a backup plan, 
enter the name in the Search by File Name field and click Search. 

3. Click the box(es) next to the folders or files you want to restore.

4. From the Restore Files to list, select a location for your restored files and click 
the Restore button. 
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Reactivating a Backup Plan

You may reactivate an old backup plan if you want to continue backing up the files 
specified in that plan.

1. On the menu bar, click Actions > Reactivate Backup Plan.

The Reactivate wizard appears.

2. Browse to select the location of the backup folder and click the Next button.

3. If you have more than one backup plan, select the one you want to reactivate and 
click OK.

4. Select the No, just reactivate the backup plan and start backing up option 
and click the Next button. Your backup plan will be reactivated, and your 
computer will back up files onto your selected backup destination.
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Important: If you select the Yes option, all the files in your backup up plan 
will be restored onto your computer. This will overwrite the files on your 
computer with the files from your backup plan. See “Restoring a Backup 
Plan” on page 35.

Editing a Backup Plan

Icons

Click the icons to add or remove files to and from backup plans, keep multiple 
revisions of files on hand for recall, remove entire plans, and view the backup log. 

Selecting a Backup Plan

If you have more than one backup plan, select the one you want by clicking in its box. 
A blue border surrounds the selected plan.

Change Selected Files

Change Selected Settings

 

Remove Backup Plan

 
 

Show Backup Log
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Changing Selected Files

1. On the WD Anywhere Backup screen, click the Change Selected Files icon. (See 
“Icons” on page 37.) The WD Anywhere Backup Configuration screen appears.

Note: To deselect all listed files, click the Select None link. To select all the listed files, click the 
Select All link.

2. Do one of the following:
• To add files, click the Add Backup Items button.
• To remove files, select the files and click the Remove Selected Items button.
• To exclude files from the backup, click the Show Advanced Options button. 

Depending on your selections, subsequent screens may display. 

3. When you finish selecting items to add or remove, click the Select (or OK, 
depending on the screen) button. 

4. When returned to the WD Anywhere Backup Configuration screen, click the 
Done button. 

Changing Backup Plan Settings

You can change the number of versions of the same files WD Anywhere Backup 
should keep. For example, you may want to keep yesterday’s version as well as 
today’s version. 
BACKING UP COMPUTERS ON A NETWORK - 38



WD SHARESPACE
USER MANUAL
1. Click the Change Selected Settings icon. (See “Icons” on page 37.) Select the 
Keep up to check box and enter the maximum number of earlier versions of your 
files to back up.

2. Click OK.

Removing a Backup Plan

You can delete a backup plan on the WD Anywhere Backup screen. Your backed up 
files remain at their destination until you delete them manually.

1. Click the Remove Backup Plan icon. (See “Icons” on page 37.)

2. In response to the confirmation message, click OK.

Showing the Backup and Error Logs

WD Anywhere keeps a log of all actions and backup errors.

1. Select the backup plan, and click the Show Backup Log icon. (See “Icons” on 
page 37.) The Backup Log appears.
BACKING UP COMPUTERS ON A NETWORK - 39



WD SHARESPACE
USER MANUAL
2. To view the error log, click the Error Log tab.

3. To see an explanation of an error in the list displayed in the lower part of the 
screen, click the error.

4. To clear selected errors, select their check box and click the Clear Selected 
Errors button.

5. To clear all errors, click the Clear All Errors button.

6. To prevent the Error Log from displaying transient errors, click the Do not notify 
me about transient errors check box. This selection affects all backup plans.

7. To see which files have been backed up, click the click here to launch the WD 
Anywhere Restore application link. (For information on restoring, see 
“Restoring a Backup Plan” on page 35.)
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4
 MioNet Remote Access

MioNet Overview

Access your photos, music, documents, and videos from anywhere, anytime using 
MioNet secure remote access services from WD. MioNet makes remote file access 
and sharing seamless, simple and very secure. Just follow the steps to register your 
WD ShareSpace into your secure MioNet account. Then you can access your 
content from any web browser in the world with your unique username and 
password. 

MioNet also enables you to share a folder of pictures on your WD ShareSpace with 
friends (no upload required) or a folder of documents with your business colleagues. 
Invitees can view the content you share with them, but nothing else.

Remote Access Setup

WD ShareSpace comes with MioNet enabled by default. The Remote Access 
menu in WD ShareSpace’s Network Storage Manager allows you to further control 
the MioNet service on the storage device. See “Remote Access” on page 85 for 
further details. 

Windows

1. Turn on your computer and wait for the operating system to load.

2. Insert the WD ShareSpace software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start 
and then Computer (Windows Vista) or My Computer (Windows 2000/XP). Right-click the CD/
DVD drive, click Open, and double-click Setup.exe.

3. Windows Vista: Click Run setup.exe and then Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen, click 
Next.
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6. Click the MioNet New Account button if you are a new MioNet user; click 
MioNet - Existing Account if you are an existing user.

The MioNet registration screen appears.

7. Complete the registration form and click Submit to create an account.
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8. When MioNet finds the WD ShareSpace you are registering, enter a name for the 
device and click OK. 

9. A confirmation message appears. Click OK.

MioNet displays a list of the public folders stored on your WD ShareSpace and 
includes a private folder that was created with the MioNet username. 

On login, MioNet searches for any unregistered WD ShareSpace units and gives 
any it finds a default name of WD Storage. MioNet names are independent of 
names assigned using WD ShareSpace’s Network Storage Manager.

When in the same local network as WD ShareSpace, you cannot access the files 
and folders through MioNet. They are only available through MioNet from a 
remote location.
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Using MioNet Web (after registration)
1. From any browser, go to www.mionet.com/web and enter your username and 

password. The Quick Start tab appears, displaying icons representing activities 
you can perform. 

Note: In this User Manual, we discuss the most basic options. For more advanced options, see the 
MioNet Help or MioNet User Guide (available when you click the Online Help icon).
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Accessing WD ShareSpace Folders and Files Remotely 

Note: Local access to WD Storage using MioNet Web is not available. Use Window’s Explorer or 
Apple Finder.

1. Click the My Resources tab to display your WD ShareSpace folders.

Your WD ShareSpace folders display in the My Resources tab of MioNet.

2. Select a folder to see a list of all the sub-folders and files. You can now use your 
browser to access your entire collection of music, photos, movies, and 
documents. 

3. Double-click any file to open it locally. You may be able to drag and drop files from 
your WD ShareSpace to the remote computer and vice versa.

Sharing Files with Others

Sharing Photos

You can easily share a folder of photos on your WD ShareSpace with others. It is a 
simple three-step process. First you choose the folder you wish to share, then who 
you want to share with, and finally what permissions they have to access the folder.

1. Click the Share Photos icon.
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2. Choose any folder or the plus sign to choose a sub folder to share with someone 
else and click the Next button.

The screen for choosing people to share with appears.

3. To share photos with MioNet users you have shared with in the past:
(a) Select the user(s) and click the Next button. 

(b) Continue with step 6.

4. To add a new user to share with: 
(a) Click the Invite new person button.

(b) Enter the user’s e-mail address and click the Continue button. 

(c) Continue with step 6.

5. To find another MioNet user you have never shared with before:
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(a) Click the Find MioNet user button.

(b) Enter the user name or e-mail address of the user and click the Find button.

(c) When MioNet finds the user, click the Share with this person button.

(d) Continue with step 6.

6. From the list of users, select the user(s) you want to share with and click the Next 
button.

Note: You can press the Ctrl key in Windows or the Command key on the Mac to select multiple 
users.
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(e) Select the permission level and click the Next button. If you want users to only view the 
photos, select read permission. If you want to enable users to add photos (or modify or 
delete photos) to your folder, give them the read/write permission.

The person you invite receives an e-mail with a link to click. MioNet automatically 
opens up in the user’s web browser and provides instant secure access to the 
folder of photos on your computer.

Transferring Files to Others

MioNet enables you to transfer files to others to whom you have granted access, and 
to have them transfer files to you.

Note: MioNet transfers are not as fast as LAN transfers.

1. Click the Transfer Files to Others icon to open a dialog window showing your WD 
ShareSpace folders.

2. Click the + to navigate through your directory to highlight the folder you wish to 
transfer files from and click the Next button.
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The following screen appears.

3. To transfer files back and forth with MioNet users you have shared with in the 
past:
(a) Select the user(s) and click the Next button. 

(b) Continue with step 6.

4. To add a new user to transfer files to and from: 
(a) Click the Invite new person button.

(b) Enter the user’s e-mail address and click the Continue button. 

(c) Continue with step 6.

5. To find a MioNet user you have never shared with before:
(a) Click the Find MioNet user button.

(b) Enter the user name or e-mail address of the user and click the Find button.
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(c) When MioNet finds the user, click the Share with this person button.

(d) Continue with step 6.

6. From the list of users, select the user(s) you want to transfer files to and from. 
Click the Next button.

Note: You can press the Ctrl key in Windows or the Command key on the Mac to select multiple 
users.

7. Select the permission level and click the Next button. If you want users to only 
transfer the files to themselves, give them the read permission. If you want to 
enable them to transfer files to you (or modify or delete your files), give them the 
read/write permission.

MioNet automatically opens up in the user’s web browser and provides instant 
secure access to the folders or files on your computer. They can then double-
click the file to open it and save it to their local PC.
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5
 How to Play/Stream Video, Music & Photos

Media Server Overview

WD ShareSpace is designed to serve as your home's central media hub. It enables 
you to stream photos, music, and videos to your home entertainment center and/or 
other PCs on your home network. 

The Twonky Media server application searches for the media in the three shared 
folders (Videos, Photos, and Music) stored on the WD ShareSpace connected to 
your home network. The server is pre-set, so you can just transfer your multimedia 
content to the respective shared folders on your WD ShareSpace (described on the 
next page), and you are ready to stream and view content on your home 
entertainment center, game consoles (for example, Xbox 360, Playstation 3, or DLNA 
1.5 Digital Media Adapters). Visit www.twonkymedia.com for further information on 
Twonky Media.

Media Types Supported

Note: Some devices may not support playback of all these files. Please refer to your device’s user 
manual to see which formats are supported.

Shared Music Shared Videos Shared Pictures

Audio files Video files Image Files

MP3
WMA
WAV
LPCM
OGG vorbis
FLAC
M4A
M4B
MP4
3GP
AAC
MP2
AC3
MPA
MP1
AIF

MPEG1
MPEG2
MPEG4
AVI / DivX
WMV
VOB
3GP
VDR
ASF
MPE, 
DVR-MS
Xvid
M1V
M4V 

JPEG
PNG
TIF
BMP 
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Media Storage

You can access and store media content on WD ShareSpace via network shares. 
Shares are folders that can be used to organize and store files on your 
WD ShareSpace. Shares can be shared with everyone (public) or with selected 
users on your network (private). 

The device comes pre-configured with the Public network share, which contains the 
following folders for media storage: 

• Shared Music - folder for storing music files you want to share with other users 
• Shared Pictures - folder for storing image files you want to share with other users 
• Shared Videos - for storing video files you want to share with other users 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Service. For more information on 
how to use Twonky media, see “Media Server” on page 125. For more 
information on how to use the iTunes service, see “iTunes” on page 126.

How and Where to Add Media Content to the Shared Folders

1. Open the Internet Explorer.

2. Copy your music files to the Shared Music folder, which is under the Public folder 
on WD ShareSpace.

3. Follow the same process to place your videos and pictures into their respective 
Shared Pictures and Shared Video folders.

Important: Make sure to sort and add your media content to the 
corresponding shared folders. (e.g., music files must go into the Shared 
Music folders). If you do not do this, your content will not display correctly 
through your digital media adapter.
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Media Devices

Now that you have copied your files to their corresponding folders, you can use a 
variety of media devices to stream media. The following types are discussed in this 
section:

• Windows Media Player 11 (Windows Vista) on page 53.
• Xbox 360 on page 55.
• Xbox 360 - New User Interface on page 56.
• Playstation 3 on page 56.
• Digital Picture Frames on page 56.
• Network Music Player on page 57.
• Digital Media Adapters on page 57.
• DLNA Devices on page page 57.

Windows Media Player 11 (Windows Vista)

How to Stream Media Using Windows Media Player 11 Library

1. Click Control Panel > Network and Sharing Center.

2. Click Customize.
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3. Click Private, and then click Next. 

4. Launch Windows Media Player (Start > All Programs > Windows Media 
Player).

5. Click Library > Media Sharing. 
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6. Click Find media that others are sharing, and then click OK. 

7. Select a media type (Music, Pictures, or Video) and click PVConnect on 
WDShareSpace. 

8. Double-click the media file you want to play.

Xbox 360

1. Ensure that your Xbox 360 and WD ShareSpace are powered on and connected 
to your local area network. The main Xbox screen displays five screens you can 
scroll through (Marketplace, Xbox Live, Media and Network).

Note: If you have any devices with Window Media Center, the Xbox 360 will display a user interface 
screen asking you to connect to that device. Click B to exit.

2. Scroll to the Media Screen and select the Music option (you have three options - 
Music, Pictures, and Videos). The Source screen appears.

3. Click WDShareSpace or the WD ShareSpace device name if you have already 
changed the names previously. (See “Device Name” on page 79.) The Music 
player screen appears with the device name at the top of the screen.

4. Click Songs to view the songs stored in your Shared Music folder.

5. Use the music player navigation buttons on the screen to play your music files.

6. To view your pictures or play video content that are on your WD ShareSpace, go 
back to step 3 and repeat the steps, selecting the appropriate media (Picture or 
Video).
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Xbox 360 - New User Interface

1. Ensure that your Xbox 360 and WDShareSpace are powered on and connected 
to your local area network.

2. From the main Xbox user interface, scroll to the My Xbox screen

3. Use the D-Pad and scroll to the right until you see Video, Music and Picture 
Library options.

4. Select any one of these three options by pressing the A button on your controller. 
The Select Source screen appears.

5. Select the WDShareSpace option based on the device name you created 
previously and press the A button. You will see the media content stored on your 
WDShareSpace unit.

6. Using the controller, scroll through to view and play your media content.

Playstation 3

1. Ensure that your Playstation 3 and WD ShareSpace are powered on and 
connected to your local area network. You will see the main user interface with a 
series of options displayed horizontally across your TV screen.

2. Using the directional buttons (left and right) on the PS3 controller, navigate to 
Music, Photo or Video depending on which type of media you want to play, and 
press the X button.

3. Using the directional buttons (up and down), scroll and select WDShareSpace 
(or the new device name that you created previously) by pressing the X button. 
You will now see a list of folders (Music, Photo and Video) to the right of the 
WDShareSpace icon.

4. Make sure that you select the folder that corresponds to option you selected back 
in Step 2. For example, if you select Photo from the main user interface screen, 
open the corresponding Photo folder to the right of the WDShareSpace icon, 
otherwise your content will not display properly.

Digital Picture Frames

The following are general steps for setting up digital photo frames:

1. Ensure that your WD ShareSpace is connected to your home’s local network and 
is powered on.

2. Follow the user instructions provided with your wireless digital photo frame to 
proceed through any initial setup or installation of drivers.

3. Using the navigation feature on your wireless digital photo frame, scan and detect 
the WD ShareSpace on your network.

4. Depending on the brand of photo frame you have, you may need to access 
Settings/Network Setup page in the user interface to establish connection so that 
your photo frame can link to your WD ShareSpace. Please refer to your DMA’s 
user guide for specific instructions.
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5. Once you have a connection between your wireless photo frame and the WD 
ShareSpace, access the Media screen on your photo frame that will provide you 
the option to view your pictures.

Please refer to your wireless photo frame user guide for supported picture file formats and 
instructions on accessing and viewing your pictures.

Network Music Player

The following are general steps for using a network music player to access WD 
ShareSpace:

1. Connect WD ShareSpace to your local area network and power on the device.

2. Connect and configure your network music player on your home’s wired or 
wireless network switch or router.

3. Turn on your network music player.

4. If connected properly, you will find the device name of your WD ShareSpace.

5. Navigate through the network music player’s user interface to locate and play 
music stored on your WD ShareSpace.

Note: Please refer to your network music player user guide for specific instructions on connecting to 
a network attached storage system and how to access and play your media content.

Digital Media Adapters

The following are general steps for using a Digital Media Adapter (DMA) to access 
WD ShareSpace:

1. Connect WD ShareSpace to your local area network and power on the device.

2. Make sure that your DMA device is connected to your TV and powered on.

3. The main screen of your DMA device appears.

4. Depending on the DMA device, you may need to access the Settings/Network 
Setup screen in the user interface to establish a connection between your DMA 
and WD ShareSpace. Please refer to your DMA’s user guide for specific 
instructions.

5. Once you have a connection established between your DMA and WD 
ShareSpace, access the Media screen on your DMA to view your pictures or 
stream music and video content from the WD ShareSpace.

Note: Please refer to your DMA’s user guide for specific instructions on connecting to the WD 
ShareSpace and how to access and play your media content.

DLNA® Devices

See specific DLNA media device user manuals for instructions on connecting a 
DLNA device to your local area network so you can access content on 
WD ShareSpace. Go to www.dlna.org for a list of DLNA-certified devices and for 
further information.
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6
 Using iTunes with WD ShareSpace

iTunes Media Server Overview

With the iTunes Media Server Service, you or anyone connected to the WD 
ShareSpace can play music files stored on the system using iTunes. This service 
creates a virtual music library on the device and treats it as an iTunes repository, 
making it possible for music files to stream from the WD ShareSpace to Windows or 
Mac computers running iTunes. 

Media Types Supported

The iTunes Server Service supports the following file types:

• *.mp3
• *.wav
• *.aac

Note: The iTunes server service requires the presence of the ‘/Public/Shared Music’ share folder. Do 
not rename or delete Shared Music if you want to use the iTunes server. You must recreate or 
rename the ‘/Public/Shared Music’ folder if it has been deleted or given another name.

Storing Content

See “Step 2: Access WD ShareSpace on the Network” on page 10 for instructions 
on moving your media files to WD ShareSpace’s ‘/Public/Shared Music’ default 
folder.

Streaming Audio in iTunes

The iTunes Service is enabled by default in the WD ShareSpace’s Network Storage 
Manager utility. See “To enable or disable the iTunes Server Service:” on page 126 
for more information.

1. Launch iTunes on your computer.

2. Click WDShareSpace under the Shared section of the left pane. If you have 
copied music to the /Public/Shared Music folder and it is in a format supported 
by iTunes, it should be listed in the right pane.
USING ITUNES WITH WD SHARESPACE - 58



WD SHARESPACE
USER MANUAL
3. Double-click an audio file to play.

The audio file is streamed in iTunes, and audio files from the WD ShareSpace are 
displayed under the Shared list.
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7
 External USB Drive Sharing & Backup

Sharing Data on a USB Drive 

You can share data on your USB drive with other users connected to the WD 
ShareSpace. When a USB storage device with the FAT, FAT32, or NTFS file system 
is connected to the network storage device, the USB device will be displayed as a 
USB share.

To share data on a USB drive:

1. Connect a USB drive to any of the three USB ports. The front port is USB1 and 
the two rear ports are USB2 and USB3 from top to bottom.

Note: The WD ShareSpace supports external USB storage; USB optical drives (CD/DVD combo or 
DVD dual/multi drive) are not supported. The USB ports currently support attached drives with 
Fat32, NTFS, EXT3 file systems. HFS+J and proprietary devices (e.g., cameras) are not currently 
supported. 

2. Open the WDShareSpace folder to access data on the USB drive. 
Double-click on the USB share. The USB share name will appear as 
usb1-1share, usb2-1share, or usb3-1share, depending on the actual USB port 
that the USB drive is connected to. 

USB Auto Backup Feature 

The WD ShareSpace’s auto backup feature allows you to back up data in either 
direction—from a USB drive to the WD ShareSpace or from the WD ShareSpace to 
a USB drive. You have to select your destination and source as described in “USB to 
WD ShareSpace Backup” on page 120.

Important: When backing up data, always connect the USB drive directly 
to USB port 1 located on the front panel. Do not use a USB hub. Ensure 
that the destination drive has enough free space to store the amount of 
data being transferred.
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To back up FROM a USB drive:

1. Connect a USB drive to the USB port (Port 1) located on the front panel, and 
wait for a few seconds for the USB backup LED  on the front of the unit to light 
steadily (this could take up to 30 seconds). 

2. Press and hold the USB backup button only until the USB backup LED  turns 
off (about 2 seconds). While the backup is in progress, the USB LED will flash 
once per second. When the backup is complete, the LED will remain on steadily. 

Note: The first backup will copy the entire first partition of the USB drive. Subsequent backups will 
copy only new and updated files.

The system will back up data from the USB drive to the “Public” default share 
folder on the WD ShareSpace. The share folder will be automatically named after 
the USB drive plugged into Port 1. 

Example: usb_Western_Digital_External_HDD-200806201424

To back up TO a USB drive:

1. Prior to performing the backup operation, make sure to choose a source and 
destination in the WD ShareSpace’s Network Storage Manager utility. See “To 
set a source share name for WD ShareSpace to USB drive backup:” on page 
121 for more information.
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2. Connect a USB drive to the USB port (Port 1) located on the front panel of the 
WD ShareSpace, and wait for the USB backup LED   to turn off (about 2 
seconds). 

3. Press and hold the USB backup button until the USB backup LED on the front of 
the unit begins to flash (about 3 seconds). The USB LED will flash twice per 
second while the backup is in progress and will light steadily when the backup is 
complete. 

The system will back up data from the pre-selected source share folder on the 
WD ShareSpace to the USB drive first partition. 

Note: If the USB drive does not have enough free space to back up the selected portion of the WD 
ShareSpace, an error will display when the USB drive is full. The error will appear as a flashing red 
LED on the front of the ShareSpace, as well as a text message at the top of the WD ShareSpace’s 
Network Storage Manager web page.
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8
 Using WD Discovery (Windows Only)

WD Discovery Overview

WD Discovery is a proprietary utility that aids in connecting to the 
WD network drives. The easy-to-use software enables you to quickly locate and set 
up the WD ShareSpace from any Windows computer on your network. With WD 
Discovery, you can easily map network drives, browse shared folders, and create a 
desktop shortcut for quick access to your WD ShareSpace.

WD Discovery provides the following options:

Mapping a Network Drive

To access and store data on WD ShareSpace after setting up the device, you must 
first map a network drive to one or more of the default shares. Install the WD 
Discovery application on each Windows XP or Vista computer in your network to 
easily map a network drive, browse network shares, or create a desktop shortcut.

Windows 2000/XP/Vista/Server 2003

Note: Follow the steps below only if you have already installed WD discovery as instructed in 
“Windows 2000/XP/Vista/Server 2003” on page 10.

1. Turn on your computer and wait for the operating system to load.

2. If WD Discovery is not running:

For Windows 2000/XP, click Start > All Programs > WD Discovery 
Software > WD Discovery or double-click the WD Discovery icon on your 
desktop. 

Configure your WD ShareSpace device using the 
WD ShareSpace’s Network Storage Manager interface. See 
“Configuring WD ShareSpace” on page 69.

Automatically map a network drive so you can easily share and 
store data on your WD ShareSpace. See “Mapping a Network 
Drive” on page 63.

Easily browse network shares without having to manually enter 
network paths. See “Browse Network Shares” on page 66.

Create a desktop shortcut that points to a networked 
WD ShareSpace. See “Desktop Shortcut Creation” on page 67.

Determine which WD ShareSpace in the network is currently 
being accessed by WD Discovery. See “Turning Identify LED On 
or Off” on page 67.
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For Vista, click Start > Programs > WD Discovery Software > WD 
Discovery or double-click the WD Discovery icon on your desktop.

WD network drives are listed in the Network Drives Found list.

3. Click the device you want to map in the Network Drives Found list and click Map 
Network Drive in the Things to Do list.

4. In the authentication screen, enter your User Name and Password. The default 
for both is “admin.”

A message appears asking whether you want to map the drive automatically. 
Continue with “Automatic Drive Mapping” or “Manual Drive Mapping” on 
page 65. 
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Automatic Drive Mapping

1. After completing step 4 of “Windows 2000/XP/Vista/Server 2003” on page 63, 
click Yes.

All share folders available on the device will be mapped as network drives 
automatically. Available drive letters are assigned backwards from Z. 

When mapping completes, the share folders appear as network drives in the 
WD Discovery screen. 

2. Click Back to return to the main page.

Manual Drive Mapping

1. After completing step 4 of “Windows 2000/XP/Vista/Server 2003” on page 63, 
click No. All share folders on the device are listed on-screen. Select a folder 
name, then select a drive letter. 

2. Click Yes to complete drive letter assignment.

3. Click My Computer on Windows 2000 or XP and Computer on Vista. The 
network drives display. You can now drag and drop files into the network drive 
folders using My Computer or Windows Explorer.
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Browse Network Shares

To access data on a share using WD Discovery:

Use WD Discovery to easily browse network shares without having to manually enter 
drive paths.

1. Ensure that the device is powered on and connected to the network. 

2. For Windows 2000/XP, click Start > All Programs > WD Discovery 
Software > WD Discovery or double-click the WD Discovery icon on your 
desktop. 

For Vista, click Start > Programs > WD Discovery Software > WD 
Discovery or double-click the WD Discovery icon on your desktop.

3. Click WDShareSpace in the Network Drives Found list and click Browse 
Network Shares in the Things To Do list. 

4. After successful login, the share folders on the device are listed. Click a share to 
view and access share files in Windows Explorer. 
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Desktop Shortcut Creation

WD Discovery can create a desktop shortcut that points to a networked 
WD ShareSpace. Follow these steps to create a desktop shortcut:

1. Ensure that the device is powered on and connected to the network. 

2. For Windows 2000/XP, click Start > All Programs > WD Discovery 
Software > WD Discovery, or double-click the WD Discovery icon on your 
desktop. 

For Vista, click Start > Programs > WD Discovery Software > WD 
Discovery, or double-click the WD Discovery icon on your desktop.

3. Click WDShareSpace in the Network Drives Found list, and then click Create 
Desktop Shortcut in the Things To Do list. 

4. A dialog appears informing you that the desktop shortcut has been created 
successfully. Click OK.

Turning Identify LED On or Off

Users with multiple WD ShareSpace devices can use the blue Identify LED feature to 
find out which WD ShareSpace in the network is currently being accessed by 
WD Discovery. WD Discovery allows you to turn on or turn off Identify LED on a 
networked WD ShareSpace. 

Note: This feature is only available on a WD ShareSpace network drive.

To turn on the Identify LED on a networked WD ShareSpace: 

1. Ensure that the device is powered on and connected to the network. 

2. For Windows 2000/XP, click Start > All Programs > WD Discovery 
Software > WD Discovery, or double-click the WD Discovery icon on your 
desktop. 

For Vista, click Start > Programs > WD Discovery Software > WD 
Discovery, or double-click the WD Discovery icon on your desktop.
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3. Click WDShareSpace in the Network Drives Found list and click Turn On 
Identify LED in the Things To Do list. 

4. The Identify LED on the target device is turned on. The LED icon appears to the 
left of the device name in WD Discovery. 

To turn off the Identify LED on a remote networked WD ShareSpace device: 

1. Ensure that the device is powered on and connected to the network. 

2. Click Start > Programs > WD Discovery.

3. Click WDShareSpace in the Network Drives Found list and click Turn Off 
Identify LED in the Things To Do list.

The Identify LED on the target device is turned off. The LED icon to the left of the 
device name in WD Discovery is also turned off. 
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9
 Network Storage Manager: Basics
WD ShareSpace’s Network Storage Manager is a powerful and convenient user 
interface for managing and configuring your WD ShareSpace.

Note: Accessing and setting up the WD ShareSpace’s Network Storage Manager is not required to 
begin using your WD ShareSpace right away.

This chapter explains how to configure the WD ShareSpace, access WD 
ShareSpace’s Network Storage Manager, and enter basic settings. For instructions 
on configuring advanced settings, see “Network Storage Manager: Advanced” on 
page 87.

Configuring WD ShareSpace

Follow the instructions below to configure your WD ShareSpace for Windows or 
Mac.

Windows 2000/XP/Vista

Note: Follow steps 1-6 below only if you have not already installed WD Discovery Tool as instructed 
on page 10. Otherwise, launch WD Discovery Tool using the desktop icon and continue with step 7.

1. Turn on your computer and wait for the operating system to load.

2. Insert the WD ShareSpace software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start 
and then Computer (Windows Vista) or My Computer (Windows 2000/XP). Right-click the CD/
DVD drive, click Open, and double-click Setup.exe.

3. Windows Vista: Click Run setup.exe, and then click Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen, click 
Next.

6. The Application Installer screen opens, displaying a list of options. Click WD 
Discovery Tool.
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7. The WD Discovery screen appears. Click WDShareSpace in the Network 
Drives Found list and click Configure.

8. The login page appears. Continue device setup by following the instructions for 
“Setting Up the Device” on page 71.

Mac OS X

1. Turn on your computer and wait for the operating system to load.

2. Open the Safari web browser.

3. Click the Bookmarks link in the upper left corner of the screen.

4. Click Bonjour, and then double-click WDShareSpace.

5. The login page appears. 

Note: The Macintosh Leopard may not be able to get past the login page. Please go to 
support.wdc.com and search the knowledge base for answer ID 3280, which has instructions on 
correcting the problem.

6. Continue device setup by following the instructions for “Setting Up the Device” 
on page 71.
NETWORK STORAGE MANAGER: BASICS - 70



WD SHARESPACE
USER MANUAL
Setting Up the Device

Follow the steps below to continue setting up the device for all operating systems. 

Note: You will only have to perform the setup the first time you log in to WD ShareSpace’s Network 
Storage Manager.

1. Enter “admin” in both the Administrator Name and Password fields. 

2. Select a language from the Language list and click Login.

3. Click Next. 
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4. Read the license agreement, and then click I Agree. 

5. In the Initial Setup screen, do the following:
(a) Enter a name in the Device Name field (up to 15 characters, including alphanumeric and 

dash ‘-’).

Note: The device name is used to identify the storage device connected to the network and appears 
in My Network Places. To connect more than one storage device to the same network, you must 
specify a unique device name for each storage device. 

Caution: Renaming WD ShareSpace forces all the network computers to remap their shared 
network resources. Change the device name only when necessary.

(b) Enter a brief description of the device in the Device Description field. The maximum length 
of the description is 42 alphanumeric characters. 

(c) Select a time zone from the Time Zone list. 

(d) If necessary, adjust the date and time manually using the Date & Time lists. 

Click Next.
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6. Enter a new admin password in the New Admin Password field. The maximum 
length of the password is 16, including alphabetic, numeric, underscore, space, 
and most special characters except double-quote ("). The first and last characters 
cannot be a space. The password is case sensitive.

7. Retype the new password in the Confirm Password field. Click Next.

Note: If you forget your admin password, you must reset the device to its default configuration using 
the reset button. See “Reset Button” on page 8 for instructions.

8. Accept the default DHCP (Dynamic Host Configuration Protocol) client settings. 
If you are not using DHCP, click Static and manually assign the IP address. Click 
Next. 
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9. The Summary screen appears. Click Finish. 

Note: If you are using Windows 2000, XP, or Vista, you may notice a warning notice bar display 
during the final initialization of your WD ShareSpace. The bar warns that the Internet Explorer has 
blocked an Active X controller message. This warning disappears on its own, or you can click the X 
button to the right of the bar. This warning does not affect setting up your drive.

Accessing WD ShareSpace’s Network Storage Manager

Once you have configured your WD ShareSpace and set up WD ShareSpace’s 
Network Storage Manager, you can manage and further configure your unit by 
entering the web-based user interface. 

Important: You must configure WD ShareSpace before using WD 
ShareSpace’s Network Storage Manager. Follow the instructions under 
“Configuring WD ShareSpace” on page 69.

Note: Accessing and setting up the WD ShareSpace’s Network Storage Manager is not required to 
begin using your WD ShareSpace.
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Windows 

1. Ensure that the device is powered on and connected to the network. 

2. If WD Discovery is not running:

For Windows 2000/XP, click Start > All Programs > WD Discovery 
Software > WD Discovery or double-click the WD Discovery icon on your 
desktop. 

For Vista, click Start > Programs > WD Discovery Software > WD 
Discovery or double-click the WD Discovery icon on your desktop.

3. Click WDShareSpace in the Network Drives Found list and point to and click 
Configure in the Things To Do list.

4. The login page appears. Type in the administrator name and password (the 
default password is “admin” unless it has already been changed by the 
administrator). In the Tool list, click WD ShareSpace’s Network Storage 
Manager. In the Language list, click the language for your region. Click Login. 

Mac

1. Turn on your computer and wait for the operating system to load.

2. Open the Safari web browser.

3. Click the Bookmarks link in the upper left corner of the screen.

4. Click Bonjour, then double-click WDShareSpace.

5. The login page appears. Type in the administrator name and password. In the 
Tool list, click WD ShareSpace’s Network Storage Manager. In the 
Language list, click the language for your region. Click Login.
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WD ShareSpace’s Network Storage Manager Features

The web-based management utility includes the following features:

• LAN access—the device supports local area network access of the web-based 
user interface, enabling management from anywhere in the network. 

• Secured access—the device can be accessed and configured by the 
web-based, password protected user interface over SSL (Secure Socket Layer).

• E-mail notification—in the event of warnings or errors related to temperatures, 
hard drive, network, or USB connection, administrators are automatically alerted 
by e-mail.

• Multiple access levels—users can be assigned different rights. The device 
supports two levels: full access and read only.

• Update via web—firmware updates can be downloaded and installed on the 
device from a computer on the LAN. 

• Disk management—the web-based user interface allows administrators to 
monitor internal hard drives and USB drives connected to the device.

• USB storage support—allows reliable data backup from a USB storage device 
to the device.

• RAID management—allows RAID configuring of the hard drives. 
• Support for Windows and Mac systems—allows users on different platforms 

to share files using CIFS (Common Internet File System), NFS (Network File 
System), or FTP (File Transfer Protocol) protocols.

• iTunes streaming support—allows users to stream photos, music, and videos 
to supported digital media adapters. 

• Twonky Media server—provides fast, convenient navigation and searching of 
all your media files in the Twonky user interface.

• Remote shutdown or reboot—allows administrators to power off or reboot the 
device from any computer on the LAN.

• System log—an efficient instrument in analyzing and solving technical issues. 
• UPS-ready—a UPS (uninterruptable power supply) device can be connected to 

one of the USB ports to provide secondary power in the event of a power failure. 
Go to support.wdc.com and search the knowledge base for answer ID 2559 for a 
list of compatible UPS devices.

• Upgradable firmware—enables you to keep your system up to date. For more 
information, see “Update (Firmware)” on page 93.
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User Interface Overview

The web-based user interface is designed to logically access and manage the 
features of the device. Upon logging in, the web user interface defaults to Basic 
Mode. Basic Mode provides access to the most common device configuration 
options. 

The Advanced Mode page includes six tabs and each tab is subdivided into several 
menu buttons providing advanced task management functions. The toolbar located 
on the upper right allows you to switch between Advanced Mode and Basic Mode 
any time. 

Note: See “Network Storage Manager: Advanced” on page 87 for instructions on using Advanced 
Mode.
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Toolbar

The toolbar located on the upper right of the WD ShareSpace’s Network Storage 
Manager user interface includes the following commands.

Basic Mode

The Basic Mode provides access to the most common configuration options. 

Click any of the icons to display the available configuration options. The table below 
describes the options. 

Function Description

Advanced Allows you to switch the user interface from basic to Advanced Mode. 

Basic Allows you to switch the user interface from advanced to Basic Mode. 

Help Displays online help. 

Logout Exits the utility.

Category Description

Device Name Enter a device name and description. For more details, see “Device Name” on page 79.

Date & Time Set the system date and time manually or set the NTP server to allow date and time to be 
updated automatically. For more details, see “Date & Time” on page 79.

Network Configure the network connection. For more details, see “Network” on page 80.

Users Create and delete user accounts and change the user password. For more details, see 
“Users” on page 81.

Folder Shares Access configuration details relating to how shares are made available through this storage 
device. This menu also displays a list of mounted volumes and their available shares. When a 
USB drive is connected to the device, the USB drive displays as USB share. For more details, 
see “Folder Shares” on page 83.

System Status Displays general information about the storage device, such as device name, firmware version, 
current date/time, system uptime, IP address, volume usage, and volume RAID type. For more 
details, see “System Status” on page 85.
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Device Name

Use this option to enter or change a device name and/or a description of the device. 
The device name is the name by which your WD ShareSpace is identified on the 
LAN. 

1. Click Device Name in Basic Mode home screen.

2. Enter or change the text in the Device Name and/or Device Description fields.

3. Click Submit. 

Date & Time

The date and time is synchronized automatically to the NTP (network time protocol) 
server by default. You have the option to set the date and time manually or allow the 
NTP to access the Internet to automatically set the time. 

Note: Time displays in 24-hour format only.

1. Click Date & Time in the Basic mode home screen.

Remote Access Enables or disables the MioNet software. Computers running MioNet can remotely access 
and share files on the storage device over the Internet. 
Note: Available only on computers running Windows. For more details, see “Remote Access” 
on page 85.

Shutdown/
Reboot

Performs device shutdown or reboot from any computer on the local area network (LAN). For 
more details, see “Shutdown/Reboot” on page 86.

Category Description
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2. Deselect Enable to set the time manually.

3. To synchronize the date and time automatically, click Enable.

4. Click Submit. 

Network

The device’s network mode is set to DHCP Client by default, which is appropriate 
for most environments. By selecting Static IP, you can manually set the IP address, 
netmask, gateway, and DNS (Domain Name Service) server IP address.   
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To configure the network settings:

1. Click Network in the Basic mode home screen.

2. In the Network Mode drop-down menu, select a network mode. Selecting DHCP 
Client as a network mode causes the device to obtain an IP address 
automatically from the local DHCP server. Selecting Static IP as a network 
mode requires you to enter IP information such as IP address, Default Gateway, 
and DNS Servers. 

3. Click Submit. 

Users

Creating users allows the administrator to control access to data on 
WD ShareSpace across the network by creating user accounts with specific 
permissions. The administrator can also edit and delete user accounts in the Users 
menu. 

Users Screen Icons

Icon Description

Denotes a user private share.

There is no private share with this user name. 

There is a private share with this user name. 

Click this icon to change the user password. 

Click this icon to delete a user. 

Click this icon to add a user. 
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To create a new user account:

1. Click Users in the Basic Mode home screen.

2. Click the Add icon . 

3. Enter the user name in the User Name field.

4. Enter the user’s full name in the Full Name field. 

5. Enter the password in the Password field.

Note: The maximum length of the password is 16 characters, including alphabetic, numeric, 
underscore, space, and most special characters except double-quote ("). The first and last 
characters cannot be a space. The password is case sensitive.

6. Re-enter the password in the Confirm Password field. 

7. Create a private user share at the same time by clicking Yes next to Create User 
Private Share. The new user is granted full access to the private share. The 
private share name is the same as the user name.

8. Click Submit. 

To change a user password:

1. Click the Change Password icon  next to the appropriate user account. 

2. Make the necessary changes, and then click Submit. 

To delete an existing user account:

1. Select the user account you want to delete, and then click the Delete icon .

2. Click OK.

For more user configuration options using the WD ShareSpace’s Network Storage 
Manager Advanced Mode, see “Users” on page 128.
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Folder Shares

Shares are folders that can be used to organize and store files on your 
WD ShareSpace. Shares can be shared with everyone (public) or with selected 
users on your network (private). 

The device comes preconfigured with three shares: 

• Public—created automatically at the factory 
• Shared Music - folder for storing music files you want to share with other users. 

• Shared Pictures - folder for storing image files you want to share with other users. 

• Shared Videos - for storing video files you want to share with other users. 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Service. For more information on 
how to use Twonky media, see “Media Server” on page 125. For more 
information on how to use the iTunes service, see “iTunes” on page 126.

• Download—for saving files using Downloader (see “Scheduled Downloads” on 
page 141).

• Configuration—this is a read-only share containing only a Help file and the login 
page. It is not meant for sharing or storing data and should not be modified.

The administrator can create private shares accessible only by user name and 
password when setting up a user account (see page 82), or by setting permissions 
on an existing share (see “Folder Share Permissions” on page 131).

You must first access WD ShareSpace’s Network Storage Manager to create a 
share. 

The Folder Shares menu provides access to a list of available shares.
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Folder Shares Screen Icons 

To create a share:

1. Click Folder Shares in the Basic mode home screen.

2. Click the Add icon . 

3. Enter a share name in the Share field. The share name can contain up to 32 
characters, including alphabetic, numeric, or underscore characters.

4. Enter a brief description in the Description field.

5. Click Submit. 

To delete existing shares:

WARNING: Deleting a share erases all data on the share. All files and 
folders on the share will be lost.

1. Select the share to delete. 

2. Click the Delete icon .

3. Click OK.

Icon Description

Denotes a user private share.

This is a publicly accessible share. 

This is a private share.

Click this icon to delete a share. 

Click this icon to add a share. 
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System Status

The System Status option displays general information about the system: device 
name, firmware version, current date/time, system uptime, IP address, volume usage, 
and volume RAID type. Click System Status in the Basic Mode home screen to 
access system information

Remote Access

WD ShareSpace comes with MioNet enabled by default. The Remote Access 
option allows you to control the MioNet service on the storage device, 

MioNet icons:

• Start/Stop MioNet - Shows Stop MioNet if MioNet is running and Start Mionet if 
MioNet is stopped.

• Restart MioNet - Stops MioNet if it is running and starts it again.
• Reset MioNet - Resets all MioNet account information on the WD ShareSpace. If 

the ShareSpace is registered to a MioNet account, that registration is erased so 
that the unit is now unregistered. This status will be displayed in the upper right 
corner of the page. Any shares created by MioNet or MioNet users will remain, 
and no data will be lost. Access to these shares over the LAN requires the use of 
the MioNet username and password.
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MioNet service status messages:

• MioNet service connection status
• Started - MioNet service is started

• Stopped - MioNet service is stopped and will start on system restart. 

• Disabled - MioNet service is disabled and will not start on system restart.

• MioNet registration status 
• Unregistered - Not currently registered to a MioNet account

• Registered - Already registered to a MioNet account

Note: A mouse-over of the registration status shows the MioNet account name if the device is 
registered. To register with MioNet, go to: www.mionet.com/WDShareSpace.

Shutdown/Reboot

The Shutdown/Reboot options allow you to perform a system reboot or shutdown.

To perform WD ShareSpace shutdown:

1. Click Shutdown/Reboot in the Basic Mode home screen.

2. On the Shutdown/Reboot page, click Shutdown. 

3. Click OK.

To perform WD ShareSpace reboot:

1. Click Shutdown/Reboot in the Basic Mode home screen.

2. On the Shutdown/Reboot page, click Reboot. 

3. Click OK. 
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10
 Network Storage Manager: Advanced
Advanced Mode provides access to additional options not available in the Basic 
Mode. When in Basic Mode, click Advanced Mode on the toolbar to view WD 
ShareSpace’s Network Storage Manager in Advanced Mode.      

The Advanced Mode page include six tabs, each having several icons providing more 
management options for maximum flexibility and security of the device. The table 
below describes the tab options available in Advanced Mode. 

Tab Description

System The System tab allows you to configure the general system settings, set e-mail or window 
alerts, change the administrator password, perform firmware upgrades, perform system 
configuration file backups, restore system to factory defaults, activate or deactivate the 
system LEDs, generate an SSL certificate, enable power saving, and perform device 
shutdown or reboot. For more details, see “System Tab” on page 88.

Network The Network tab has access to all network configuration options, such as setting DHCP / 
Static mode, changing the IP address, netmask, gateway, DNS server IP address, configuring 
jumbo frames, and configuring membership in a domain or workgroup. For more details 
“Network Tab” on page 101. 

Storage The Storage tab provides a list of all supported drives it locates on the system. It also allows 
you to configure the RAID capability of the hard drives, manage file share preferences, set the 
backup destination folder, set disk quotas, and set a share folder for users. For more details, 
see “Storage Tab” on page 109.

Media The Media tab allows you to enable or disable the streaming option in iTunes or access the 
Twonky Media server. For more details, see “Media Tab” on page 125.

Users The Users tab allows you to add, modify, and delete users and groups, and change all user 
and group permissions (read/write, read only, no access) to shares/folders and USB storage 
devices. For more details, see “Users Tab” on page 128. 

Status The Status tab displays general information about the system such as device name, firmware 
version, current date/time, machine up-time, memory and swap activity, and load averages. 
This tab also allows viewing of logs from the system, Common Internet File System (CIFS), or 
File Transfer Protocol (FTP). For more details, “Status Tab” on page 136.
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System Tab

The System tab allows you to set the system date and time, set up alerts, change 
the admin password, perform software or firmware upgrades, create a backup copy 
of the system files, restore the system to factory defaults, generate and set up an 
SSL certificate, or perform system reboot or shutdown. 

The System tab provides access to the following configuration options: 

• General Setup 
• Alerts Setup
• Admin Password
• Update
• Restore Configuration 
• Advanced
• UPS
• Shutdown/Reboot

General Setup

The General Setup icon on the System tab allows you to perform basic 
configuration of device. You can provide a name and brief description for the device, 
select a compatible web access protocol, and set the time zone. You can set the date 
and time manually or enable automatic time synchronization by NTP (Network Time 
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Protocol) Service. You can also manually specify the IP address of the NTP servers to 
which you want to synchronize. 

To configure system general setup settings:

1. Assign a device name for this storage device in the Device Name field. The 
device name can contain up to 15 characters, including alphabetic, numeric, and 
hyphens only.

2. Enter a brief description for this storage device in the Device Description field. 
The maximum length of the description must not be more than 256 alphanumeric 
characters.

3. In web access protocol, select either of the following web access protocols:
• Hypertext Transfer Protocol (HTTP) is a communications protocol for the transfer of 

information on the intranet and the World Wide Web.

• Hypertext Transfer Protocol over Secure Socket Layer or HTTPS is a URL scheme 
used to indicate a secure HTTP connection. HTTPS is syntactically identical to the http:// 
scheme normally used for accessing resources using HTTP. All traffic between the managing 
computer and the WD ShareSpace is encrypted. HTTPS provides a more secure means of 
configuring your device, but it may affect the responsiveness of the user interface.

4. To set the date and time manually, deselect Enable next to NTP Service. 

5. Select a time zone from the Time Zone list. 

6. Adjust the date and time manually in the Date & Time lists. 

7. Click Submit.
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Alerts Setup

Using the Alerts Setup icon on the System tab, you can configure e-mails or popup 
messages that provide alerts for system conditions such as over temperature; hard 
drive, volume, network, and USB status; and user and group events. These alerts 
help the system administrator(s) manage and detect events or errors. 

To set up automatic e-mail notifications:

1. Click Enable next to Email Notification. The page displays additional fields.
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2. In the SMTP Server field, enter the name or IP address of the SMTP server used 
for e-mail. (Check with your Internet Service Provider (ISP) for the SMTP server 
settings, which may include the SMTP port, and ask whether to enable TLS/SSL 
or SMTP authentication.)

3. In the Email Return Path field, enter a valid return email address recognized by 
your ISP. For example, if your SMTP server is "smtp.myisp.net", then you should 
enter a valid return email path address of the form "myname@myisp.net". 

4. In the Email Recipients field, enter the e-mail address where you want to send 
an e-mail message when an event occurs. Up to five e-mail addresses can be 
used at a time. 

5. Click Send Test Mail to send a test alert and confirm your settings are correct. 
A test message will be sent to each entered e-mail address.

6. Click Submit.

To configure alerts to send pop-up messages when an event occurs:

Note: Pop-up notification only works with Windows XP. 

For a list of events, see “System Events” on page 156.

1. On the Alerts Setup page, click Enable next to Pop-Up Notification. 

2. Enter the name of the computer in the Notified Devices field. When an event 
occurs, a pop-up message will appear on the computer. Up to five computer 
names can be added to the alert list.

Note: To find the name of your computer, click Start and right-click Computer or My Computer, 
click Properties, and then click the Computer Name tab (Windows XP).

3. Click Send Test Pop-up to send a test alert and confirm that the settings are 
correct.

Note: Make sure the Messenger Service is activated on the computers to which you want to send 
the pop-up message when an event occurs. To enable Messenger Service, go to Start > Control 
Panel > Administrative Tools > Services > Messenger. You can test the Messenger Service 
by clicking Send Test Pop-up. Make sure printer and file sharing is selected as an exception if the 
Windows Firewall is enabled in Windows 2000/XP.
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4. Click Submit. 

Admin Password

The Admin Password icon on the System tab allows you to change the 
administrator’s password. 

To change the administrator's password:

1. In the Old Password field, enter the old password.

2. In the New Password field, enter the new password. The maximum length of the 
password is 16, including alphabetic, numeric, underscore, space, and most 
special characters except double-quote ("). The first and last characters cannot 
be a space. The password is case sensitive.

3. In the Confirm Password field, re-enter the new password.

4. Click Submit.
NETWORK STORAGE MANAGER: ADVANCED - 92



WD SHARESPACE
USER MANUAL
Update (Firmware)

The Update icon on the System tab provides information about the current firmware 
version and allows you to perform a firmware update either automatically or manually.

Automated

The Automated tab on the Update page provides information about the current 
firmware version and connects to the WD website for automatic downloading of the 
latest firmware. 

1. Click Check For New Firmware. 

2. Click Download if new firmware is available. 

3. Click Upgrade. Wait for the update process to complete. 

WARNING! Do not interrupt a firmware upgrade in progress; doing so 
may cause the device to malfunction or render it unable to boot.
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After your firmware has been updated, the device will reboot. The user interface 
redirects to the System Information page after the update has completed.

Manual

The Manual option allows you to install the firmware manually.   

1. Before attempting a manual update, check support.wdc.com for firmware 
availability.

2. If a new firmware file is available, download it from support.wdc.com. 

After your firmware has been updated, the device will reboot. The web user interface 
redirects to the System Information page after the update is completed.

Note: If the IP address of your unit has changed, you will need to use WD Discovery Tool to discover 
it again.
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Configuration

The Configuration icon allows you to save or restore system configuration settings or 
revert to factory default settings.

To back up the current system configuration settings:

1. On the Restore Configuration page, click Save Current Configuration. 

2. Specify a file name and location for saving the file. 

3. Click Save. 
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To restore saved configuration settings:

1. On the Restore Configuration page, click Browse. 

2. Select the previously saved system configuration file. 

3. Click Open.

4. Click General Restore or Full Restore. Selecting General Restore will restore 
all features to previously saved settings (data volume and shares settings 
excepted). All current system configurations will be lost. Full Restore restores all 
features, including the data volume and shares, to previously saved settings. All 
current system configurations and user data is lost when using Full Restore.

5. Click OK. 

To restore the device to factory defaults:

Important: Save the current configuration prior to restoring the factory 
default settings. 

Performing a factory default reset will erase all settings in the WD ShareSpace. 
System configuration will reset the device to default factory settings. All 
information and data will be lost. The LAN settings (including port settings) are 
not changed. After the reset, the administrator login/password will be changed to 
“admin/admin.”

1. On the Configuration page, click Restore Factory Default. 

2. Click OK. 

During the system restore process, the system will turn off the power LED and 
blink the backup LED. Wait until the system restore process is completed. 

Note: You cannot access the configuration web pages if you forget the administrator password, IP 
address setting, or device name. Use the reset button to restore these settings (including IP setting, 
device name, and administrator password) to factory default configuration. To use this function, 
press and hold the reset button on the back of the device (next to power interface) for at least 10 
seconds. The system reboots automatically and you can then use the default settings to access the 
device. 
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Advanced 

The Advanced icon on the System tab allows you to configure the device’s 
identification LED and configure the system for a secure connection by generating a 
key and an SSL certificate. You can also set the extend Span mode and enable HDD 
standby mode. 

To turn on the system identification LED: 

System Identification identifies the location of the device. If you have multiple devices 
installed, you can use this function to turn on the identification LED and know which 
device you are configuring.

1. Click ON to enable the system identification LED. 
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To generate an SSL certificate and key pair automatically: 

1. Click HERE In the Auto Generate field of the SSL certificate/key. The SSL 
Certificate/Key Generation dialog appears. 

2. Enter the identification information you want to include in the certificate/key pair.

3. Click Submit. 

To generate an SSL certificate and key pair manually:

1. Using your preferred method, generate an RSA private key and paste it in the 
appropriate fields.

2. Click Submit.

To select extend disk mode: 

1. Select Auto Extend or Manual (Extend Disk) Mode:

Auto Extend only applies when RAID type is Span. It will extend an existing Span 
automatically when you add a new drive and reboot the system. Manual allows 
you to choose when to add the new drive after boot up.

2. Click Submit.

To enable HDD standby:

If the HDD Standby function is enabled, the hard drives go into standby mode to save 
power after a fixed period of no activity. This period varies from 125 seconds to 375 
seconds.

1. Click Enable next to HDD standby. 

2. Click Submit. 

Note: The Power Save feature allows drives to spin down when not in use. The fan will continue to 
operate. 

3.  Enter the identification information you want to include in the SSL certificate/key 
pair, and then click Submit.
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UPS

A UPS (uninterruptable power supply) device can be connected to one of the USB 
ports to shut down the ShareSpace in the event of a power failure. You must connect 
the UPS device to the WD ShareSpace before setting up the UPS service.

Note: Go to support.wdc.com and search the knowledge base for answer ID 2559 for a list of 
compatible UPS devices.

UPS Setup

The UPS Setup tab allows you to modify UPS settings. 

To enable the UPS service:

1. Click the UPS Setup tab.

2. Click Enable in UPS service. 

3. Enter the timeout value. 

4. Click Submit. 

Note: During a power failure, the system will shut down after TIMEOUT seconds have expired, or the 
remaining battery percentage reaches 15% or less, or the remaining battery runtime drops to or 
below 5 minutes. A value of '0' disables the Timeout timer.
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UPS Status

The UPS Status tab provides information about the connected UPS device, 
including model, battery level and runtime, timeout, and status. 

Shutdown/Reboot

The Shutdown/Reboot menu allows you to perform system reboot or shutdown.

To perform WD ShareSpace shutdown:

1. Click Shutdown/Reboot in the System tab home screen.

2. On the Shutdown/Reboot page, click Shutdown. 

3. Click OK.
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To perform WD ShareSpace reboot:

1. Click Shutdown/Reboot in the System tab home screen.

2. On the Shutdown/Reboot page, click Reboot. 

3. Click OK. 

Network Tab 

The Network tab provides access to the following configuration options:

• LAN
• Services
• Workgroup
• Remote Access

LAN

The LAN icon on the Network tab allows access to all network configuration options 
including setting the connection method, changing the IP address, netmask, 
gateway, and DNS (Domain Name Service) server IP address, as well as changing 
the MTU size to enable jumbo frames.
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To configure the network settings:

1. In the Network Mode drop-down menu, select a network mode. Selecting DHCP 
Client as a network mode will cause this storage device to obtain an IP address 
automatically from the local DHCP server. Selecting Static IP as a network mode 
requires you to assign IP information such as IP address, Default Gateway, and 
DNS Servers. 

2. If your network link speed is 1000 Mbps, the MTU field will be available. Enter the 
MTU (Maximum Transmission Unit) value for the jumbo frame. The default MTU 
setting is 1500 bytes. Any value larger than this is considered a jumbo frame. The 
network card on the client computer must support jumbo frames.

Note: For the MTU size larger than 1500, the client machine and the network switch must also 
support the same MTU size. The common MTU size for jumbo frame is '9004'. The rule for 
calculating valid MTU is (MTU size - 1500) mod 8 = 0 ('xxx mod 8' means the value 'xxx' can be 
divided by 8). 
The range of valid IP addresses for each class: 
- Class A: 1.0.0.1 to 126.255.255.254 
- Class B: 128.1.0.1 to 191.255.255.254 
- Class C: 192.0.1.1 to 223.255.254.254 

3. Click Submit. 
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Services

The Services icon on the Network tab allows you to set protocols for sharing files 
and folders on the device. 
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• Universal Plug and Play (UPnP) is a set of computer network protocols that 
simplifies the implementation of networks in the home by allowing devices to 
connect seamlessly.

• File Transfer Protocol (FTP) is a network protocol used to transfer data from 
one computer to another through a network. FTP is a popular choice for 
exchanging files independent of the operating systems involved.

• Network File System (NFS) is a network file system protocol that allows a user 
on a client computer to access files over a network as easily as if the network 
devices were attached to its local disks. Generally used on UNIX systems.

• Web Access
• Hypertext Transfer Protocol (HTTP) is a communications protocol for the transfer 

of information on the intranet and the World Wide Web.

• Hypertext Transfer Protocol over Secure Socket Layer or HTTPS is a 
URL scheme used to indicate a secure HTTP connection. It is syntactically identical to the 
http:// scheme normally used for accessing resources using HTTP.

To enable UPnP NAT Traversal for Web Access & FTP:

1. Click Enable in UPnP for Web Access & FTP.

2. Click Submit. 

The UPnP NAT Traversal combines with the UPnP feature and NAT feature. 
Universal Plug and Play (UPnP) is an architecture for pervasive peer-to-peer 
network connectivity of PCs and intelligent devices. The Network Address 
Translation (NAT) is used in gateway devices that form the boundary between the 
public Internet and the private LAN. As IP packets from the private LAN traverse 
the gateway, NAT translates a private IP address and port number to a public IP 
address and port number, tracking those translations to keep individual sessions 
intact. 

To enable other network services:

1. Click Enable in network service. 

2. If you have selected FTP as your network service, click Yes to enable or click No 
to disable anonymous login, and then click Submit. 

3. If you have selected NFS as your network service, the IP allowed field appears. 
You will be prompted to enter the IP filters that are allowed for NFS service. Click 
Add to add a new IP filter, and then click Submit. 

Note: In IP Allowed field of NFS service, '*' means allow all IP addresses. If you intend to allow 
specified IP addresses or range, please modify '*' in IP Allowed field. 
Mount point for NFS share is /nfs/SHARENAME, Ex. /nfs/Public. 

4. You can specify particular port numbers for HTTP, HTTPS, and FTP services 
respectively. Instead of selecting the Default radio button, you can specify the 
port number between 8000 and 10000 for each service. 

Note: In IP Allowed field of NFS service, '*' means allow all IP addresses. If you intend to allow 
specified IP addresses or range, please modify '*' in IP Allowed field. 
Mount point for NFS share is /nfs/SHARENAME, Ex. /nfs/Public. 
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To access data via FTP:

You can access data in a shared folder on WD ShareSpace with a widely used FTP 
client software program. An FTP client software program must be installed on the 
computer you are using to access the device, and FTP service must be enabled on 
the WD ShareSpace (see “To enable other network services:” on page 104 and “To 
modify properties of the share:” on page 118 for details).

1. Open an FTP client software program.

2. Enter ftp://username@IP address as the host name 
(e.g., ftp://admin@172.25.102.67) or just the device’s IP address depending on 
the FTP client software program you are using.

Note: Click System Status in either the basic or Advanced Mode to view the device's IP address.

3. Enter the WD ShareSpace user name and corresponding password.

4. Click Connect or OK.

You can now upload files to or download files from WD ShareSpace across the LAN. 
It is possible to upload files to or download files from WD ShareSpace across the 
Internet (WAN), but this requires custom router configuration and is recommended 
only for advanced users.

Workgroup

The Workgroup icon on the Network tab allows you to set up the network storage 
device as a workgroup or a domain member. The default setting is Workgroup. 

Domains are controlled from a central location (domain controller) and require central 
authentication before you can join them. Workgroups, in contrast, are much simpler 
to control. As long as you know the workgroup name, you can add any computer to a 
workgroup.

If your network uses a domain (has a Windows 2003 Active Directory Service 
(ADS)), you may wish to connect this device as a domain member. When configured 
as a domain member, the device will ask the ADS to authenticate users. Therefore, as 
a domain member, the device provides user-level security. 

ADS enables the administrator to manage users’ permissions in a central location 
and to propagate these permissions to multiple devices. For example, any device that 
has a domain on ADS inherits the user list and associated permissions.

When joining a domain, the device must be authorized by the domain's administrator. 
You must enter the fully qualified Domain Name, Domain Controller IP Address, 
Domain Administrator Name, and Domain Administrator Password for the 
authorization. 
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To set up a workgroup name:

1. Click Workgroup as the Mode option. 

2. Enter a name for your workgroup in the Workgroup Name field. 

3. Click Submit. 

To join a domain (Windows 2003 Server only):

1. Click Domain Member. 

2. Enter the fully qualified domain name in the Domain Name field. 

3. Enter the domain administrator IP address in Domain Controller IP Address 
field. 

4. Enter the domain administrator name in the Administrator field. 

5. Enter the domain administrator password in the Administrator Password field. 

Note: The local user and domain user share the same access control rights if the user name of the 
local and domain users are the same (FTP service excluded).

6. Click Submit. 
NETWORK STORAGE MANAGER: ADVANCED - 106



WD SHARESPACE
USER MANUAL
When the process is complete, a confirmation message appears.

If changes are made at the Active Directory server to either users or groups or 
both, you can manually update the list on the WD ShareSpace. (See “Folder 
Share Permissions” on page 131.)

Note: You can enable ADS to automatically update the WD ShareSpace. Contact WD Tech 
Support for more information on this procedure. 

Remote Access

WD ShareSpace comes with MioNet enabled by default. If MioNet is not already 
installed on the client computer, follow the instructions under “Configuring WD 
ShareSpace” on page 69. The Remote Access icon allows you to control the 
MioNet service on the storage device.

MioNet Icons

• Start/Stop MioNet - Shows Stop MioNet if MioNet is running and Start Mionet if 
MioNet is stopped.

• Restart MioNet - Stops MioNet if it is running and starts it again.
• Reset MioNet - Resets all MioNet account information on the ShareSpace. If the 

ShareSpace is registered to a MioNet account, that registration is erased so that 
the unit is now unregistered. This status will be displayed in the upper right corner 
of the page. Any shares created by MioNet or MioNet users will remain, and no 
data will be lost. Access to these shares over the LAN requires the use of the 
MioNet username and password.
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MioNet service status messages:

• MioNet service connection status
• Started - MioNet service is started

• Stopped - MioNet service is stopped and will start on system restart. 

• Disabled - MioNet service is disabled and will not start on system restart.

• MioNet registration status 
• Unregistered - Not currently registered to a MioNet account

• Registered - Already registered to a MioNet account

Note: A mouse-over of the registration status shows the MioNet account name if the device is 
registered. To register with MioNet, go to: www.mionet.com/WDShareSpace.
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Storage Tab

The Storage tab provides all necessary options required for individual storage disk 
configuration and maintenance. This tab also includes an option to change the 
system’s RAID configuration, set a share name, and format and safely remove the 
USB drives connected to the system. 

The Storage tab provides the following configuration options:

• Disk Manager
• Volumes & RAID Management
• Folder Shares
• USB Shares
• Quota 
• Downloads
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Disk Manager

The Disk Manager icon on the Storage tab displays the installed hard drives in the 
device. This page also displays detailed information about each drive, such as disk 
size, disk description, and status. 

Drive status messages include the following:

• Good—Indicates the hard drive is accessible and functioning normally. 
• Failed—Indicates a fatal error has occurred on the hard drive(s). See “Replacing 

a Drive” on page 147 for drive replacement instructions. 
• Foreign—Indicates the device has detected a hard drive that was used on 

another computer. 

To clean up a disk:

If the hard drive is foreign or used, the Clean Disk  icon appears on the right side 
of the Disk Management table. Clean Disk erases the previous partition to allow 
creation of a new volume. 

To safely remove a disk:

If the hard drive is not part of an existing volume, the Safely Remove Disk  icon 
appears on the right side of the Disk Management table and allows you to safely 
remove the drive. 
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Volumes and RAID Management

The Volumes page includes two tabs—Manage Volume and Manage RAID. 

Manage Volume

The Manage Volume tab lists all the volumes available on the device and provides 
detailed information about each volume such as description, RAID type, usage, size, 
and volume status. 

Note: If the volume RAID type is Span and there are new disks in the system, the Extend icon 
appears on the side of the Manage Volume table. 
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Volume status messages include the following:

• Good—Indicates the volume is accessible and hard drive is functioning normally. 
• Failed—Indicates a volume cannot be started automatically, the disk may be 

damaged or the file system may be corrupt. 
• Resyncing—Occurs when creating a mirror or when a mirrored volume is being 

resynchronized. 
• Formatting—Indicates volume is being formatted.
• Degraded—Missing one drive in a RAID 1 or RAID 5 configuration.
• Recovering—The failed drive is being copied to a working drive in a RAID 1 or 

RAID 5 configuration. 

To display more detailed information, click on an underlined status.

To modify the volume:

1. Click the Manage Volume tab.

2. Click the Modify  icon next to the volume you want to modify. The Volume & 
Raid Management page appears.

3. Select a RAID level.

4. Click Submit. 

To delete a volume:

1. Click the Delete  icon.

2. Click OK. 

Note: Only ExtendVolume can be deleted.
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Manage Volume Options

The table below shows available volumes for systems containing one to four drives.

Manage Volume 
available options starting mode + 0 Drives

manual
extend
span

available + 1 Drive

manual
extend
span

available + 2 Drives

manual
extend
span

available + 3 Drives

manual
extend
span

available - 1 drive - 2 drive - 3 drive

1Drive span span no

span,
stripe,
mirror yes

span,
stripe,
RAID 5 yes

span,
stripe,

RAID 5, 
two

mirrors yes

2 Drive span

span,
stripe,
mirror no

span,
stripe,
RAID 5 yes

span,
stripe,
RAID 5 yes span 

2 Drive mirror

span,
stripe,
mirror no

span,
stripe,
RAID 5 no

span,
stripe,
RAID 5 no span 

2 Drive stripe

span,
stripe,
mirror no

span,
stripe,
RAID 5 no

span,
stripe,
RAID 5 no span 

3 Drive span

span,
stripe,
RAID 5 no

span,
Stripe,
RAID 5 yes

span,
stripe,
mirror span 

3 Drive stripe

span,
stripe,
RAID 5 no

span,
Stripe,
RAID 5 no

span,
stripe,
mirror span 

3 Drive RAID 5

span,
stripe,
RAID 5 no

span,
Stripe,
RAID 5 no

span,
stripe,
mirror span 

4 Drive span

span,
Stripe,
RAID5 no

span,
stripe,
RAID 5

span,
stripe,
mirror span 

4 Drive stripe

span,
Stripe,
RAID5 no

span,
stripe,
RAID 5

span,
stripe,
mirror span 

4 Drive RAID 5

span,
Stripe,
RAID5 no

span,
stripe,
RAID 5

span,
stripe,
mirror span 

4 Drive

two mirrors 
(each

separate
volume would 

have these 
options just as 

with a two-
drive mirror)

span,
Stripe,
mirror no span
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Manage RAID

Configure RAID on the hard drives using the Manage RAID tab on the Volume 
Management submenu. 

WARNING! Changing the RAID configuration causes all volumes and 
data to be lost. 

RAID (Redundant Array of Independent Drives) refers to an array of multiple 
independent hard drives that provide high performance and reliability. RAID function 
depends on the number of drives present and the RAID level selected. 

The WD ShareSpace supports the following RAID levels: 

• RAID 0 (Striped) - Provides data striping (spreading out blocks of each file 
across multiple hard drives) but no redundancy. This improves performance but 
does not deliver fault tolerance. If one drive fails then all data in the array is lost. 

• RAID 1 (Mirrored) - Provides disk mirroring. Mirroring creates an exact copy (or 
mirror) of a set of data on two drives, which increases reliability compared to a 
single drive. If either drive fails, the other continues to function as a single drive 
until the failed drive is replaced. Note this RAID type has the highest disk 
overhead (100%) of all RAID types. This option is only available with two drives 
installed.

• Two Mirror - Two Mirror mode is available when four drives are installed in the 
WD ShareSpace. In this mode, two independent RAID 1 volumes are created.
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• Span (Spanned) - Combines drives into a linear fashion to create one large 
logical volume. Unlike RAID 0, which “stripes” all data bitwise to all drives, the 
volume is linear across both drives. A spanned drive is literally like a single bigger 
drive, in that files written to the volume earlier go to the “beginning” of the volume, 
on the first physical drive. As the volume fills, files written later are written toward 
the “end” of the volume, on the second drive. Like RAID 0, no data redundancy is 
provided. If one of the drives fails, all data is lost. 

• RAID 5 - Requires a minimum of 3 drives to implement. Similar to RAID 0 but 
adds fault tolerance by including parity information with the data. Parity is 
generated on Writes, recorded in a distributed location, and checked on Read. In 
this mode, failure of a single drive does not cause loss of data.

To configure the Manage RAID tab:

Note: Be sure to back up all data before configuring RAID. All data stored in the hard drive is lost 
when changing the RAID configuration. 

1. Click the Manage RAID tab. 

2. Select a RAID configuration 

DataVolume is the default volume. 

3. Click Submit. 
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Manage RAID Options

Any existing mode can be changed to any other available mode using the Manage 
RAID option. The following table provides the available modes and data availability for 
a WD ShareSpace when adding one or more drives.

Folder Shares

Shares are folders that can be used to organize and store files on your 
WD ShareSpace. They can be shared with everyone (public) or with selected users 
on your network (private). 

The device comes preconfigured with three shares: 

• Public—created automatically after initial setup 
• Shared Music - folder for storing music files you want to share with other users. 

• Shared Pictures - folder for storing image files you want to share with other users. 

• Shared Videos - for storing video files you want to share with other users. 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Service. For more information on 
how to use Twonky media, see “Media Server” on page 125. For more 
information on how to use the iTunes service, see “iTunes” on page 126.

• Download—for saving files using Downloader (see “Scheduled Downloads” on 
page 141).

• Configuration—this is a read-only share containing only a Help file and the login 
page. It is not meant for sharing or storing data and should not be modified.

The administrator can create private shares accessible only by user name and 
password when setting up a user account (see “To create a new user account:” on 
page 82), or by setting permissions on an existing share (see “Folder Share 
Permissions” on page 131).

Starting Configuration + 0 Drives + 1 Drive + 2 Drives + 3 Drives - 1 drive - 2 drives - 3 drives

1 Drive span

span, 
stripe, 
mirror

span, 
stripe, 
mirror, 
RAID 5

span, 
stripe, 
RAID5, 

2 mirrors x x x

2 Drive

span, 
stripe, 
mirror

span, 
stripe, 
mirror, 
RAID 5

span, 
stripe, 

RAID 5, 
2 mirrors x span x x

3 Drive

span, 
stripe, 
mirror, 
RAID 5

span, 
stripe, 

RAID 5, 
2 mirrors x x

span, 
stripe, 
mirror span x

4 Drive

span, 
stripe, 

RAID 5, 
2 mirrors x x x

span, 
stripe, 
mirror,  
RAID 5

span, 
stripe, 
mirror span
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The Folder Shares menu provides access to a list of available shares. 

USB share naming corresponds to the following configuration: 
usb-<port number>share<partition number>

To create a share:

1. Click the Add icon . 

2. Enter a share name in the Share field. The share name can contain up to 32 
characters, including alphabetic, numeric, or underscore.

3. Enter a brief description in the Description field.

4. Click a file sharing protocol next to Services. The WD ShareSpace supports the 
following file sharing services (protocols):
• CIFS (Common Internet File System) - Allows access to share files via the CIFS 

protocol. The access control for CIFS is set as share-based. This means that a user must 
enter a valid account and password for accessing the share, and users can only access the 
shares to which they have been granted access rights (Read Only or Full Access). CIFS is 
the recommended file sharing protocol for Windows platform, and allows users to access 
shares through My Network Places. Mac OS X or later also supports the CIFS protocol. 

• File Transfer Protocol (FTP) is a network protocol used to transfer data from one 
computer to another through a network, such as the Internet, using an FTP client program. 
FTP is a popular choice for exchanging files independent of the operating systems involved.

• Network File System (NFS) is a network file system protocol that allows a user on a client 
computer to access files over a network as easily as if the network devices were attached to 
its local disks.

Note: For FTP and NFS, enable manually on the Advanced Mode Network Services page. 
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5. Select a logical volume you want to share from the Volume list. 

6. Click Setup access control after creating this share to set access control 
for the new share. For more information, see “To edit the access rights of users or 
groups:” on page 132.

7. Click Submit. 

To modify properties of the share:

Note: Properties for the Public and Download shares cannot be modified, and these shares cannot 
be deleted.

1. Select the share you want to modify, and then click the Modify icon . 

2. Enter a new share name. The share name can contain up to 32 characters, 
including alphabetic, numeric, or underscores.

3. Enter a brief description.

4. Select a file sharing protocol. 

5. Click Submit. 

To delete existing shares:

1. Select the share to delete. 

2. Click the Delete icon .

3. Click OK.
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USB Shares

The USB Shares icon provides three tabs—USB Disk, USB to WD ShareSpace 
Backup, and WD ShareSpace to USB Backup. Use these tabs to format a USB 
drive, remove a USB drive, and perform backup operations from a USB drive to the 
WD ShareSpace and vice-versa. When a USB storage device with the FAT, FAT32, 
or NTFS file system is connected to the network storage device, the USB device will 
be displayed as USB share.

USB Disk

Use the USB Disk tab to format or safely disconnect a USB drive or to configure 
auto backup. (See “USB Auto Backup Feature” on page 60.)

To format a USB drive:

1. Connect a USB drive to the device.

Note: The WD ShareSpace supports USB flash disk and external USB drives; USB optical drives 
(CD/DVD combo or DVD dual/multi drive) are not supported.

2. On the USB Management page, click the USB Disk tab. 

3. Select the USB disk to format, and then click the Format icon . A dialog box 
warns that all data will be erased.

Warning! Formatting hard drives erases all the disk contents, including 
partition tables, logical volumes, and all shared folders, subfolders, and 
files. Perform this procedure only when it is safe to proceed. When 
formatting a USB drive, only one partition is created, and the partition is 
formatted as FAT32.
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4. Click OK. The USB LED will blink while the drive is being formatted.

5. Once the LED stops blinking, remove the USB drive from the WD ShareSpace. 

To safely remove a USB drive:

Note: Whenever a USB device is disconnected without first being ejected or dismounted, there is a 
risk of data loss or damage to the USB drive. With the safe remove disk option you can safely 
remove any USB drive attached to the device.

1. On the USB Disk tab, select a USB disk.

2. Click the Safely Remove Disk icon . 

3. Click OK.

USB to WD ShareSpace Backup

Use the USB to ShareSpace Backup tab to set a destination share for a different 
USB drive backup. 

To set a destination share name for the USB drive to WD ShareSpace backup:

1. On the USB Shares page, select the USB to WD ShareSpace Backup tab. 

2. Select a share to be used as a destination share from the Destination Share 
list.

3. Click Submit. 

Note: If no destination is selected, backup to the WD ShareSpace is disabled.
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WD ShareSpace to USB Backup

Use the WD ShareSpace to USB Backup tab to set a source share for this 
backup method. 

To set a source share name for WD ShareSpace to USB drive backup:

1. On the USB Shares page, select the WD ShareSpace to USB Backup tab. 

2. Select a share to be used as source share from the Source Share list. 

3. Click Submit. 

Note: If no source is selected, backup from the WD ShareSpace is disabled.

Quota

The Quota icon allows administrators to enable or disable quota control for the 
device and set grace time and quota limits for each user. 

Quota is used to limit the maximum storage capacity for each user. The accumulated 
files or folders stored in a volume for the specified user cannot exceed the quota 
setting. Once the user data exceeds the quota, a 7-day (by default) grace period 
commences. The user still can store up to 100 MB of additional data on the volume 
within the grace period. When the grace period expires, the user cannot store 
additional data on the volume until deleting the amount of data required to reduce the 
total capacity used to below quota setting.
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Manage Quota

The Manage Quota tab in the Quota Management menu provides the quota 
information for each volume and allows administrators to modify the quota settings. 

Note: Use the Manage Quota tab to enable quota globally, and use the DataVolume User 
Quota tab to enable quota per person.   

To configure disk quota:

1. Select the volume you want to modify, and then click the Modify icon . 

2. Click Enable next to Quota Service to enable disk quota service. 

3. Specify the grace period after which no additional drive space is provided. 

4. Click Submit. 
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DataVolume User Quota (or ExtendVolume User Quota)

The DataVolume User Quota (ExtendVolume User Quota) tab provides user quota 
information details and allows administrators to modify the user quota setting if two or 
more volumes are available.

To modify the user quota setting:

1. Select the volume you want to modify, and then click the Modify  icon. 

2. Click Enable next to Quota Service to enable disk quota service. 

3. Specify the amount of time the saved or backup files will be retained in the 
system. 

4. Click Submit. 
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Downloads

The Downloads icon provides two tabs—Setup Destination Share and Change 
Password. This menu provides configuration options for selecting the Downloads 
target share and changing the Downloader login password. This login provides non-
administrator users with a method to download files directly to the WD ShareSpace.

Set up Destination Share

Use the Setup Destination Share tab to choose the target share for the 
Downloader utility. For more information on how to use the Downloader utility, refer to 
“Scheduled Downloads” on page 141.

To set the destination share name for the Downloader:

1. On the Downloads page, click the Setup Destination Share tab. 

2. Select the folder to share with others from the Destination Share list. 

3. Click Submit. 

Note: If no destination is selected, the download utility is disabled. For instructions on using the 
download utility, see “Downloader Features” on page 142.

Change Password

The Change Password tab allows you to change the Downloader’s password. 

To change the Downloader’s password:

Note: The default password is “downloader.” The user name is always “downloader.”

1. On the Downloads page, click the Change Password tab. 

2. Enter a password in the Change Password field. The maximum length of the 
password is 16, including alphabetic, numeric, underscore, space, and most 
special characters except double-quote ("). The first and last characters cannot 
be a space. The password is case sensitive.

3. Re-enter the password in the Confirm Password field. 
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4. Click Submit. 

Media Tab

The Media tab provides access to the Media Server and iTunes icons. 

Note: The Media Server and iTunes servers only work on the LAN.

Media Server

Note: It is not mandatory to access the Twonky Media server to search for or play media files as long 
as the file is in its respective media folder (videos, photos, or music).

The Twonky Media server application searches for the media in the three shared 
folders (Videos, Photos, and Music) stored on the WD ShareSpace connected to 
your home network. The server is pre-set, so you can just transfer your multimedia 
content to the respective shared folders on your WD ShareSpace (described on the 
next page), and you are ready to stream and view content on your home 
entertainment center, game consoles (for example, Xbox 360, Playstation 3, or DLNA 
1.5 Digital Media Adapters). Visit www.twonkymedia.com for further information on 
Twonky Media.
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 iTunes

Enable the iTunes Server Service and customize the service settings using the 
iTunes menu. iTunes Server Service allows iPod and iTunes users to share and play 
music on the WD ShareSpace. 

Note: iTunes service is enabled by default.

When the iTunes Service is enabled in the WD ShareSpace’s Network Storage 
Manager, you or anyone connected to the WD ShareSpace can play music files 
stored on the system using iTunes. This service creates a virtual music library on the 
device and treats it as an iTunes repository, making it possible for music files to 
stream from the WD ShareSpace to Windows or Mac computers running iTunes. 

The iTunes Server Service supports only the following file types:

• *.mp3
• *.wav
• *.aac

Note: The iTunes server service requires the presence of the /Public/Shared Music share folder. Do 
not rename or delete Shared Music if you want to use the iTunes server. You must recreate or 
rename the /Public/Shared Music share if it has been deleted or given another name.

To enable or disable the iTunes Server Service:

1. On the iTunes Server Service page, click Enable next to iTunes Service. Or, 
deselect the option to disable it. 

2. Specify how often iTunes will scan the device for new music files. 

3. Click Submit. 

To customize media library update frequency:

1. Select an option in the Check for new music every list. 

2. Click Submit.
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To stream audio in iTunes:

1. Make sure that the iTunes Service is enabled in the WD ShareSpace’s Network 
Storage Manager utility. See “To enable or disable the iTunes Server Service:” on 
page 126 for more information.

2. Click WDShareSpace under the Shared section of the left pane. If you have 
copied music to the /Public/Shared Music folder and it is in a format supported 
by iTunes, it should be listed in the right pane.

3. Double-click an audio file. 

The audio file is streamed in iTunes and audio files from the WD ShareSpace are 
displayed under the Shared list.

Note: Both the Media Server and the iTunes server only work on the LAN.
NETWORK STORAGE MANAGER: ADVANCED - 127



WD SHARESPACE
USER MANUAL
Users Tab

The Users tab provides access to the following configuration options:

• Users
• Groups
• Folder Share Permissions
• USB Share Permissions

Users

The Users icon on the Users tab allows administrators to create, edit, and delete 
user accounts from Access Control list management. 
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To create a new user account:

With this feature, you can create user accounts on the WD ShareSpace and further 
customize these accounts with privilege levels. 

1. Click the Add icon . 

Note: The password can contain up to 16 characters, including alphabetic, numeric, underscore, 
space, and most special characters except double-quote ("). The first and last characters cannot be 
a space. The password is case sensitive.

2. Click Grant Administration Rights to provide the user with administrative 
rights. Administration rights allow the user to configure the device.

3. Enter the user name in the User Name field.

4. Enter the user’s full name in the Full Name field. 

5. Enter the password in the Password field.

6. Re-enter the password in the Confirm Password field. 

7. If desired, select a previously created Group for the user to join from the Group 
List. 

8. Click the >> button to add the selected user to the group. 

9. You may create a private user share at the same time by clicking Yes next to 
Create User Private Share. The new user is granted Full Access to the private 
share. The private share name is the same as the user name. Nobody else has 
access to this private share unless it is specifically granted by the administrator.

10.Select a volume that you want the user to access. 

11.Select one or more file sharing protocols to access private shares. 

12.Click Submit. 
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To modify a user account:

1. Select the user account to modify, and then click the Modify icon . 

2. Make the desired changes, and then click Submit. 

To delete an existing user account:

1. Click the Delete icon  next to the user account you want to delete.

2. Click OK.

Groups

The Groups icon on the Users tab allows the administrator to create, edit, and 
delete a group from Access Control list management. 

To create a group:

1. Click the Add icon . 

2. Assign a new group name. 

3. Enter a description of the new group.

4. Select users from the User List field to add to the User Joined field. 

5. Click the >> button. 
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6. Click Submit. 

To modify a group:

1. Select the group you want to modify, and then click the Modify icon . 

2. Make the desired changes, and then click Submit. 

To delete a group:

1. Select the group you want to delete, and then click the Delete icon .

2. Click OK.

Folder Share Permissions

The Folder Shares menu allows you to set the access control for each user or group 
in the Access list. 

• Public Access 

• Full Access  

• Read Only  

• Deny Access  

• Not Assigned 

When there is a conflict in the access rights of the user and group, the WD 
ShareSpace uses the following rules to handle the conflict:

• Deny Access will have the highest priority. 
• Full Access + Read Only = Full Access. 
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If the access control is assigned to users or groups, the full access, read only, and no 
access icons appear on the Share Access page. You can move your mouse over the 
icon to view the user or group list. 

To edit the access rights of users or groups:

1. Select a user or group, and then click the Edit icon .

2. Click Enable next to Public Access to allow everyone to access to the share. 

3. Select an access option. 

4. In the Not Assigned Users list, select the users to whom you want to grant full 
access, read only permission, or no access to the share. 

5. Click the >> button.

6. In the Not Assigned Groups list, select the local groups to which you want to 
grant full access, read only permission, or no access to the share. 

7. Click the >> button.
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8. Click Submit.

Note: Public shares can be accessed using the administrator name and password as well as a guest 
name and password. The guest name and password are both “guest.” 
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USB Share Permissions

The USB Shares icon on the Users tab allows you to set access control for the two 
USB ports on the back of the device. 

The types of access control that you can assign to a user or group include: 

• Public Access 

• Full Access  

• Read Only  

• Deny Access  

• Not Assigned  

When there is a conflict in the access rights of the user and group, the device uses 
the following rules to handle the conflict: 

• Deny Access will have the highest priority. 
• Full Access + Read Only = Full Access. 

If access control is assigned to users or groups, the full access, read only, and no 
access icons appear on the Share Access page. You can move your mouse over the 
icon to view the user or group list.

To edit the access rights of users or groups:

1. Select the share you want to modify by clicking the Edit  icon next to that 
share.

2. Click Enable next to Public Access to allow everyone to access the share. 

3. Select an access option. 

4. In the Not Assigned Users list, select the users to whom you want to grant full 
access, read only permission, or no access to the share. 

5. Click the >> button.
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6. In the Not Assigned Groups list, select the local groups to which you want to 
grant full access, read only permission, or no access to the share. 

7. Click the >> button.

8. Click Submit.
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Status Tab

The Status tab provides access to the following configuration options. 

• System Status
• System Logs

System Status

The System Status icon on the Status tab displays general information about the 
system: device name, version, current date/time, system uptime, IP address, volume 
usage, and volume RAID type if RAID is functioning properly. If RAID is not healthy, 
the RAID/Volume Usage field displays “failed.” 
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System Logs

The System Logs icon on the Status tab provides access to four tabs that display 
the events recorded by the system. You can view information such as file and 
services requested on the device, and requests between the device and client 
computers. You can also change the order and number of the log entries shown on 
log pages. 

System

The System tab displays system logs on the device.

The System Log records events that occur in the system. You can obtain information 
from the following conditions or errors that may occur in the system components, and 
hardware or software components. 

• System shutdown
• System reboot
• Factory default restore failed
• System temperature warning
• Disk SMART failure
• Volume failed or does not exist
• Volume space is full or close to 100%
• Unsafe removal of a USB mass storage device
• Resync volume failed
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The following types of events are logged:

• Critical—An event such as fan failed, system temperature has exceeded the 
threshold level, Disk SMART failed, volume space is full or close to 100%, extend 
volume failed, or resync volume failed. When a critical event occurs the power/
system status LED lights up and the system record events in the System Log. 

• Warning—An event that is not necessarily significant, but may indicate a 
possible future problem. An e-mail or pop-up message alert is sent to notify user 
of the problem that occurred in the system. 

• Information—An event that describes the successful operation of an 
application, driver, or service. 

CIFS

The CIFS (Common Internet File System) tab displays logs of file and services 
requested on the device for connections that use this protocol. 
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FTP

The FTP (File Transfer Protocol) tab displays logs of the requests and records 
transferred between the device and client computers for connections that use this 
protocol. 

Settings 

The Settings tab assigns the order and number of log entries that appear on the 
Logs page. 
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To configure the log settings:

1. On the Settings tab, click Show log entries in reverse order to display the 
most recent entries at the top.

2. Enter the number of entries you want to appear on the System, CIFS, and FTP 
logs.
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11
 Scheduled Downloads
Downloader is a powerful tool for managing download tasks directly to the unit. This 
tool is great for when you want to download very large or multiple large files from the 
Internet and do not want to sit and wait for the download to complete. All you have to 
do is identify the URL of the files you want to download from the Internet and set it in 
the Download function on your WDShareSpace. Then you can walk away and let this 
tool do the rest. All the files that you want to download are saved directly to your 
WDShareSpace and you do not even need to have your computer on. For example, 
this is the ideal tool for downloading from video file sharing websites.

With a user-friendly interface, the Downloader supports multiple simultaneous 
downloads with various functions to manage downloads. Use Downloader to 
download files to a default share folder in the WD ShareSpace and share the files 
among many users. To use Downloader, you must set a default share folder to 
Download in the WD ShareSpace’s Network Storage Manager utility. For more 
information, see “To set the destination share name for the Downloader:” on page 
124.

Accessing Downloader

Important: To access Downloader, make sure a destination folder is 
properly configured in the WD ShareSpace’s Network Storage Manager 
utility. If no destination is specified, Downloader is disabled. Refer to “To 
set the destination share name for the Downloader:” on page 124.

You can access Downloader by entering the system’s web-based user interface. See 
“Accessing WD ShareSpace’s Network Storage Manager” on page 74 for 
instructions. 

1. In the Tool list, click Downloader.

2. Enter “downloader” in both the Administrator Name and Password fields and 
click Login.

Note: You can change the password, but the administrator name is always “downloader.”
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Downloader Features

Downloader includes the following features:

• Download faster with instantaneous “start”
• Simultaneous download of multiple files from the Internet
• Files are automatically stored to a user-defined destination folder in 

WD ShareSpace.
• Automatically store your partially downloaded files in the database to resume 

downloading at any time
• Set download speed to reduce bandwidth consumption 
• Schedule and queue downloads
• Resume downloading a partial download

User Interface Overview

The Downloader user interface includes two tabs — Tasks and Settings. 

Tasks

The Tasks tab includes a table that displays the file transfer processes. The status of 
the file download is displayed using icons located on the File Name column and 
located immediately below the Submit button provides detailed information about the 
meaning of each status icon. The command icons located on the right-side of the 
tasks table allow you to add download entries, stop file download, or delete 
download task.   
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Command icons

The Downloader Tasks tab includes the following commands:

Settings

Set the download speed, create, and schedule several downloads using the 
Settings tab. 

Icon Command Description

Add Creates a download task. 

Start Starts a specific download task. 

Stop Ends the download task. 

Delete Deletes download task from the table. 

Help Displays the online guide. 

Logout Exits the Downloader utility.
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Using Downloader

To create a download task:

1. On the Tasks page, click Add . 

2. Enter the full web address from which you want to download the file in the URL 
field. 

3. If a user name and password is required to download the file, click User name 
and password are required, and then enter the user name and password. 

4. If you want to enter a new name for the file, enter a new name in the Save As 
field. 

5. Click Automatically to start downloading immediately after the request.

6. Click Submit. 

To stop and resume a download task:

1. Select a task in the Tasks table. 

2. Click Stop  to stop the download task. 

3. Click Start  to resume download task. 
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To delete a download task:

1. Select a task in the Tasks table. 

2. Click Delete  to delete the download task.

3. Click OK, and then click OK again. 

4. Click Submit. 

To change the order of the download queue:

1. Use the arrow buttons to change the order of download tasks or to make a task 
conditional on a previous task. 

2. Select a task in the Tasks table, and then click Move Up  or Move Down . 

3. Click Submit. 

To customize the Downloader settings:

1. On the Downloader page, click the Settings tab.

2. Select a number to specify the maximum number of simultaneously running 
downloads in the Max. Running No. field. 

3. Specify the decimal numbers to limit the downloaded speed if you don't want to 
consume the entire available bandwidth in Downloader in the Download Speed 
field. 

4. Set up the proxy in the Proxy field to download files if your network environment 
doesn't allow making direct connections to an external network. 

5. Click Enable next to Schedule to enable scheduled downloading time. 

Periods of time during which downloading is allowed are indicated in yellow. 
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6. Click Submit.
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12
 Replacing a Drive
WD ShareSpace is a limited user-serviceable product which allows replacement of 
any or all internal hard drives in the enclosure. 

Important: The WD ShareSpace enclosure is designed to support only 
WD hard drive assemblies. Visit support.wdc.com and search the 
knowledge base article 2569 for detailed instructions on obtaining a 
replacement drive for this product. Use only WD hard drive assemblies or 
your warranty will be voided.

An amber LED on the front of the drive denotes a faulty drive. For more information on 
LEDs, see page 7. For more information on drive status, do the following:

1. Open WD Discovery and select the unit.

2. Click Configure and log in.

3. Click the Advanced view and then click the Storage tab.

4. Click the Disk Management button. The “Unassigned” drive is the defective 
one. Note the drive number for reference if you need to replace a drive.

In the event a fault occurs and you would like to service the device yourself, visit 
WD Technical Support at support.wdc.com and search the knowledge base 
article 2569 for detailed instructions on obtaining a replacement drive. When 
contacting Technical Support, have the following items ready: serial number of 
the device, date of purchase, and the serial number of the internal hard drive(s) 
which require replacement. Once you have received the replacement drive(s), 
follow the steps below to service the WD ShareSpace.

Before getting started, power off the unit and disconnect all of its cables. 

ESD precautions

Electrostatic discharge (ESD) can damage the processor, disk drives, mainboard, 
memory modules, and other notebook components. Always observe the following 
precautions before you install a hard drive.

• Do not remove a component from its protective packaging until you are ready to 
install it.

• Do not touch the component pins, leads, or circuitry.
• Wear a wrist grounding strap and attach it to a metal part of the computer before 

handling components. If a wrist strap is not available, maintain contact with the 
computer throughout any procedure requiring ESD protection.

• Keep the work area free of nonconductive materials, such as ordinary plastic 
assembly aids and foam packing.

To replace an internal drive:

1. Turn off the system.

2. Unplug all cables from the power outlets.
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3. Place the enclosure on a flat, stable surface. 

4. Observe ESD precautions when handling a system component.

5. Remove the system cover. 
(a) Loosen the two captive screws on the rear of the system cover.

(b) Slide the cover towards the back of the system until the tabs on the cover disengage from the 
slots on the unit.

(c) Lift the cover to remove it, and then set it aside. 

Note: The drive number is stamped to the left of the drive.

6. Remove the failed drive from the drive bay.

CAUTION: When pulling out the hard drive using the mounting rails handle, use your hand to 
support it from underneath so it does not fall. 

(a) Pull on the center of the mounting rails handle and move the assembly from side to side to 
disengage the side latches. Carefully slide the drive out 1 inch from its bay. 

(b) While pulling out the drive assembly with one hand, use your other hand to support the drive 
while sliding it out of the enclosure. 
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7. Remove the drive carrier.
(a) Flex the back pin of the side rail from the hard drive and gently pull the side-rail away from the 

hard drive. 

(b) Remove the drive from the drive carrier. 

8. Remove the new hard drive from its packaging. 

9. Install the new drive into the drive carrier.
(a) Insert the new drive into the drive carrier. 

(b) Flex the left and right-side rail and insert the pins into the drive’s mounting holes. 

10.Slide the drive carrier all the way into the drive bay, then push directly on the 
drive (not on the mounting rails) until the assembly latches securely into place. 
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11.Replace the system cover. 
(a) Carefully place the system cover on the unit so that the tabs on the cover align with the slots 

on the unit. 

(b) Slide the cover toward the front of the unit until it is fully closed. 

(c) Tighten the captive screws on the rear of the unit. 

12.Reconnect the cables and power on the unit. 

13.The drive starts the rebuild process automatically. The RAID rebuild may take up 
to 34 hours depending on RAID mode and drive capacity and activity. See the 

screen shot in “Volumes and RAID Management” on page 111.

Important: Some RAID modes do not allow you to use the device during 
the rebuild process.

Note: For RAID modes other than RAID 1 and RAID 5, data cannot be written until the rebuild is 
complete.

14.Once the rebuild is complete, the power LED will change from flashing green to 
steady green.

15.Connect the interface cable and set up the new drive for RAID configuration (for 
related instructions, refer to “Manage RAID” on page 114).

16. If the faulty drive is within the warranty period, contact WD Technical Support for 
instructions on returning the drive.

Important: Do not disassemble the internal drive and attached assembly 
components. Return the entire internal drive assembly intact to WD.
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13
 Troubleshooting
For any issue, first ensure that you are using the latest firmware for WD ShareSpace. 
The latest firmware includes the latest network and SATA disk drivers. See “Update 
(Firmware)” on page 93 for instructions.

First Steps Checklist
• AC power available at the wall outlet?
• Is the power supply plugged in?
• Check the DC cable(s) on the back of the chassis and the AC source.
• Check the cable from the wall o the power supply and the cable from the power 

supply to the chassis.
• Are all cables correctly connected and secured?
• Are all peripheral devices installed correctly?
• Are all device drivers properly installed?
• Did you press the power button on the front panel to turn the device on (power 

indicator should be lit)?
• Is the power cord properly connected to the device and plugged into an outlet for 

100-127 V or 200-240 V?

Resetting the WD ShareSpace 

To reset the system using the reset button:

If you have forgotten your password, or if the network is misconfigured, pressing the 
reset button while the device is powered up resets the admin user name and 
password and IP settings to the default values without erasing shared folders or 
volumes. Follow the instructions below to reset the device using the recovery button.

WARNING: Do not move the unit while it is turned on.

1. Carefully turn the device around so that you have access to the back of the unit.

2. Ensure that the device is powered on and that the LAN connection at the back of 
the device is active (designated by a green light).

3. Locate a single, small opening in the back of the device just above the power 
connector. The reset button is inside this opening. 

4. Insert the end of an unfolded paperclip into the opening, then press and hold the 
reset button with the paperclip end. (Do not release the button.)
TROUBLESHOOTING - 151



WD SHARESPACE
USER MANUAL
5. Continue holding the reset button for about seven seconds until the HDD LEDs 
on the front panel light up. After 14 seconds, the HDD LEDs turn amber.

6. Release the reset button by removing the paperclip. The device will automatically 
reboot.

The reset operation is complete when the device has rebooted and the LAN 
connection lights and HDD LEDs are on. A successful reset results in restoring 
the device name, IP address, admin user name, and admin password to factory 
default (WDShareSpace, DHCP client, admin and admin). 

Note: The default user name and password is admin.

To reset the system to factory default settings:

Performing a factory default reset using the WD ShareSpace’s Network Storage 
Manager erases all settings, shares, and data files in the WD ShareSpace. All 
information and data is lost. For detailed instructions, see “To restore the device to 
factory defaults:” on page 96.

Hardware Diagnostic Testing

This section provides a detailed approach to identifying a hardware problem and 
locating its source.

CAUTION! Before disconnecting any peripheral cables from the system, turn off the WD 
ShareSpace and any external peripheral devices. Failure to do so can cause permanent damage to 
the WD ShareSpace and/or the peripheral device.

1. Turn off the WD ShareSpace and all external peripheral devices. 

2. Make sure the power cord is plugged into a properly grounded AC outlet.

3. Turn on the device. If the power indicator on the front panel does not light, see 
“Power indicator does not light.” on page 153.
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Specific Problems and Corrective Actions

The following contains specific problems that may arise during the use of your server. 
Possible solutions are listed for each problem. 

Power indicator does not light.

Do the following:

• Make sure the power button on the control panel is turned on. 
• Make sure the power cord is connected correctly. 
• Make sure that the wall outlet has power. Test it by plugging another device. 

HDD activity indicator does not light.

If the drives are pre-installed, contact WD Technical Support (support.wdc.com). 
Make sure that WD hard drives are installed in the WD ShareSpace.

System cannot connect to a network and network status indicator does not light.

• Make sure the network cable is securely attached to the correct connector on the 
rear panel of the device.

• Try a different network cable.
• Make sure the network switch or router has power. 

Do the following:

• Check the cabling and network equipment to make sure that all cables are 
properly connected.

• Try another port on the switch.

Can I use USB auto backup to back up a USB drive with multiple partitions to the device?

Yes, but only data stored on the first partition of a USB drive connected to the front 
port is backed up to the WD ShareSpace.

WD ShareSpace’s Network Storage Manager does not appear when I click Configure in WD 
Discovery.

Make sure JavaScript is enabled in your browser. See your browser’s Help menu for 
instructions.
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I received a banner warning message, email alert, or pop-up screen indicating a failed volume.

Do the following:

1. Verify hard drive status in the Disk Manager submenu. See “Disk Manager” on 
page 110. If the status of any drive is “Failed,” visit WD Technical Support at 
support.wdc.com and search the knowledge base article 2569 for detailed 
instructions on obtaining a replacement drive.

2. If Disk Manager does not indicate that a hard drive has failed, power cycle the 
device.

3. If the volume that failed is a new volume, try rebuilding the RAID array. See 
“Manage RAID” on page 114 for details. If this does not resolve the problem, visit 
WD Technical Support at support.wdc.com and search the knowledge base 
article 2569 for detailed instructions on obtaining a replacement drive.

My router has failed or is not available. How do I access my data in the device?

Do the following:

1. Connect the device directly to the computer's Ethernet port. 

2. Launch WD Discovery Tool and see “Mapping a Network Drive” on page 63 for 
instructions on how to access data in the device.

I received the message “iTunes server cannot find the path to Shared Music.”

The iTunes server requires the presence of the /Public/Shared Music share folder. 
Do not rename or delete Shared Music if you want to use the iTunes server. You must 
recreate or rename the /Public/Shared Music share if it has been deleted or given 
another name.

I cannot start WD Discovery to access the configure feature.

Do the following:

1. Click Start > Run.

2. Type \\WDShareSpace, and then click OK (if the device name was changed, type 
\\yournewdevicename).

3. The WD ShareSpace directory appears (Public, Configuration, and Download 
folders). Double-click the Configuration folder.

4. Double-click index.html. The configuration login screen appears.
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My router has failed. How do you map the drive letter without WD Discovery Tool?

Do the following:

1. Double-click My Computer.

2. Click My Network Places.

3. On the Tools menu, point to Map Network Drive.

4. In the Folder drop-down list, select \\device name\public. 

5. Click the Finish button.You will be prompted to log in to the share.

6. Go back to the opening window of My Computer to view the public folder of 
your device under Network Drives.

I am unable to play music, videos, or view pictures through my digital media adapter.

The media adapter requires the presence of the /Public/Shared Music, /Public/
Shared Pictures and /Public/Shared Videos share folder. Do not rename or delete 
the shared folders if you want to use the media adapter. You must recreate or rename 
the share if it has been deleted or named something else.

Because there are many kinds of file formats for pictures, videos and music, your 
particular digital media adapter may not support a format to play or display it. 
Depending on the digital media adapter device (for example, Xbox, PS3, Windows, 
and Media Center) that you have, you may need to update your device with the 
proper CODECs to support the media format that you want to play. Please refer to 
your digital media adapter’s user manual for further information of how to locate and 
update CODECs.
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System Events

The following table describes the event types that are recorded in the system log. 

Event type and 
Event ID

Event 
state

Event 
value

Critical Warning

System events

Startup [none]

Abnormal Shutdown [none]

Shutdown [none]

Reboot [none]

Software Update Succeeded Version

Software Update Failed

Factory Default Succeeded

Configuration Restore Succeeded

Configuration Restore Failed

iTunes Directory Not Exist

Fan thermal events

Fan 1 Normal RPM

Fan 1 Failed*

Thermal 1 Normal Degrees

Thermal 1 Exceeded the threshold (Overheated) Degrees

HDD SMART events

HDD [1,2,3,4] HDD SMART OK

HDD [1,2,3,4] HDD SMART fail

Volume events

Volume [1,2]

Volume [1,2] RAID volume in normal mode

Volume [1,2] RAID volume in degraded mode

Volume [1,2] RAID(0,1,5) volume resyncing Progress

Volume [1,2] Sent if volume could not be recovered

Volume [1,2] Volume doesn't exist

Volume [1,2] Volume created

Volume [1,2] Volume deleted

Volume [1,2] Volume modified

Volume usage events

Volume [1,2]

Volume [1,2] Volume has 25~100% free capacity
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Volume [1,2] Volume has more than 10% free 
capacity

Volume [1,2] Volume has more than 5% free 
capacity

Volume [1,2] Volume has reached 80% capacity

Volume [1,2] Volume has reached 95% capacity

Volume [1,2] Volume has reached full capacity

Volume [1,2] Volume had NOT been mounted

Network events

LAN 1 Link Ok Speed 
(Mbps: 
1000/
100/10)

LAN 1 Link down

LAN 1 Use dynamic IP address got from 
DHCP

IP 
address

LAN 1 Can not get IP address from DHCP, 
use default

IP 
address

LAN 1 Use static IP address IP 
address

USB events

USB [1] One-touch backup to external drive 
did not finish because external drive is 
full

USB [1,2,3] USB drive insertion

USB [1,2,3] USB drive safely removed

USB [1,2,3] USB drive unsafely removed

USB [1,2,3] USB drive format OK

USB [1,2,3] USB drive format fail

User events

[User ID] User quota is normal

[User ID] User quota reached 90%

[User ID] User quota is full

[User ID] User created

[User ID] User deleted

[User ID] User modified

Group events

[Group ID] Group created

[Group ID] Group deleted

Event type and 
Event ID

Event 
state

Event 
value

Critical Warning
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* A fan failed event is issued when the device temperature is greater or equal to 40°C (104°F).

[Group ID] Group modified

Other events

Volume [1,2] Volume extend failed

Volume [1,2] Volume resync failed

Event type and 
Event ID

Event 
state

Event 
value

Critical Warning
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14
 Glossary
CIFS — Common Internet File System. The recommended file sharing protocol for 
Windows platform allows users to access shares through My Network Places. Mac 
OS X or later also supports the CIFS protocol. See also Protocol.

DHCP — Dynamic Host Configuration Protocol. A protocol for assigning IP 
addresses to devices on a network. With dynamic addressing, a device can have a 
different IP address each time it connects to the network. In some systems, the 
device's IP address even changes while it is still connected. DHCP also supports a 
mix of static and dynamic IP addresses. See also Protocol.

DLNA — Digital Living Network Alliance. The group of consumer electronics, 
computing industry, and mobile device companies that sets standards for product 
compatibility, thus enabling users to share content in their home.

DMA — Digital Media Adapter. A device that gives home entertainment devices the 
ability to transfer media such as music, photos, videos to and from other devices over 
the network.

DNS — Domain Name Service. A system that allows a network name server to 
translate text host names into numeric IP addresses used to uniquely identify any 
device connected to the Internet.

ESD — Electrostatic discharge.

Ethernet — A standard method of connecting computers to a Local Area Network 
(LAN) using coaxial cable.

Extended Partition — A partition on a disk where non-system files (other than DOS 
or operating system files) can be stored. Multiple partitions can be created on a hard 
disk: one primary partition and one or more extended partition(s). Operating system 
files must reside on the primary partition; logical drives can be created on an 
extended partition.

FAT — File Allocation Table. A data table stored at the beginning of each partition on 
a disk and used by the operating system to determine which sectors are allocated to 
each file and in which sequence.

FAT32 — A file allocation table system with a maximum file transfer of 4 GB and a 
maximum partition size of 32 GB.

File Transfer Protocol (FTP) — A network protocol used to transfer data from one 
computer to another through a network. FTP is a popular choice for exchanging files 
independent of the operating systems involved.

GreenPower™ Technology — Engineering technology developed by WD to bring 
more energy-efficient hard drive options to our customers. WD hard drives with 
GreenPower technology yield average power savings of 4-5 watts over competitors' 
drives while maintaining solid performance. 

Host — The computer to which other computers and peripherals connect. 
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Host Adapter — A plug-in board that acts as an interface between a computer 
system bus and a hard drive.

Host Interface — The point at which a host and a drive are connected to each 
other.

Host Transfer Rate — The speed at which a host computer can transfer data 
across an interface.

HTTP — Hypertext Transfer Protocol. Protocol used by the World Wide Web to 
transfer information between servers and browsers. See also Protocol.

HTTPS — Hypertext Transfer Protocol over Secure Socket Layer. A protocol that 
provides a more secure means of configuring your device than HTTP, but may affect 
the responsiveness of the user interface. All traffic between the managing computer 
and the WD ShareSpace is encrypted. See also Protocol.

Hub — In a network, a device joining communication lines at a central location, 
providing a common connection to all devices on the network.

Identity LED — Indicates which WD ShareSpace in the network is currently being 
accessed via WD Discovery. 

Interface — A hardware or software protocol to manage the exchange of data 
between a device and a computer; the most common ones are EIDE (also known as 
PATA), SATA, and SCSI. See also Protocol.

IP — Internet Protocol. A system that controls how data messages are separated into 
packets, routed from the sender, and reassembled at the destination. See also 
Protocol.

IP address — A 32-bit, binary number that uniquely identifies a computer connected 
to the Internet.

LAN — Local Area Network. A system in which computer users in the same company 
or organization are linked to each other and often to centrally-stored collections of 
data in LAN servers.

LED — Light-emitting Diode. An electronic device that lights up when electricity is 
passed through it.

Media Server — Device that stores and shares media files (digital audio, digital 
video, and digital photos).

Media Storage — Device that stores media files (digital audio, digital video, and 
digital photos).

Memory — A device or system capable of storing and retrieving data.

MioNet® — WD remote computer access service. Adding MioNet to your home or 
work computer allows you secure and instant access from any PC in the world back 
to your computer. You can use your applications and access and share files on your 
computer or storage device from anywhere. 
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Mirroring — The process of generating an exact copy of saved data from one drive 
to another drive within a RAID 1 system. Each drive can be accessed and read 
separately. A mirrored drive can be removed from a system while the other drive(s) 
are still active. See also RAID 1.

MP3 — MPEG-audio layer 3. A digital audio coding scheme for distributing music 
over the Internet.

Multi-user — A system in information technology that enables more than one user to 
access data at the same time.

NAS — Network Attached Storage. Hard disk storage that is set up with its own 
network address rather than being attached to the computer that is serving network 
workstation users.

NAT  — Network Address Translation. Used in gateway devices that form the 
boundary between the public Internet and the private LAN. As IP packets from the 
private LAN traverse the gateway, NAT translates a private IP address and port 
number to a public IP address and port number, tracking those translations to keep 
individual sessions intact. 

Network Computer — A computer that communicates with a central data storage 
facility such as a server or RAID system.

NFS — Network File System. A network file system protocol that allows a user on a 
client computer to access files over a network as easily as if the network devices 
were attached to its local disks. Normally associated with UNIX systems. See also 
Protocol.

NTFS — NT File System. A file system, designed for Windows® NT, that supports 
long filenames, security access control, recovery, and other features.

NTP — Network Time Protocol. A protocol for synchronizing the clocks of computers 
and equipment over a network. See also Protocol.

Operating System — Software that allows users and programs installed on your 
system to communicate with computer hardware such as a hard drive.

Partition — A logical division on a hard drive that the operating system treats as a 
separate hard drive. Each partition is assigned a unique drive letter.

Port (Hardware) — A specialized outlet on a device for connecting to other devices 
using a cable or a plug. Ethernet ports, power ports, and USB ports are examples.

Protocol — A convention of data transmission that defines timing, control format, 
and data representation.

RAID — Redundant Array of Independent Disks. A grouping of hard drives in a single 
system to provide greater performance and data integrity.

RAID 0 — RAID protocol in which data is striped across multiple hard drives, 
enabling the accelerated reading and recording of data by combining the work of two 
or more drives to increase performance. See also Striping.
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RAID 1 — RAID protocol in which two copies of the data are instantaneously 
recorded — each on separate hard drives. RAID 1 ensures the protection of users' 
data because in the event that one of the hard drives fails, the other hard drive(s) will 
continue to read and write data until the faulty hard drive is replaced and rebuilt to 
once again safely mirror the data. See also Mirroring.

RAID 5 — For systems with three or more drives, RAID 5 offers fast performance by 
striping data across all drives. It protects data by dedicating a quarter of each drive to 
fault tolerance, leaving three quarters of the system capacity available for data 
storage.

RAM — Random Access Memory. Memory that allows any storage location to be 
accessed randomly, as opposed to sequential access devices such as tape drives.

ROM — Read-Only Memory. An integrated circuit memory chip containing programs 
and data that the computer or host can read but cannot modify. A computer can read 
instructions from ROM but cannot store data in ROM.

Share — A folder that can be used to organize and store files on your WD 
ShareSpace. Shares can be shared with everyone (public) or with selected users on 
your network (private).

SMB — Server Message Block. File-sharing protocol for Windows platform that 
allows users to access shares through My Network Places. Mac OS X or later also 
supports the CIFS protocol. See also Protocol.

SMTP — Simple Mail Transfer Protocol. Standard for transferring e-mail across the 
Internet. See also Protocol.

Spanned — Combines drives in a linear fashion to create one large logical volume. A 
spanned drive is like a single, bigger drive, in that files written to the volume earlier go 
to the “beginning” of the volume, on the first physical drive. If one of the drives fails, all 
data is lost. 

SSH — Secure Shell. A network protocol that uses encryption and authentication 
keys to enable two devices on the network to exchange data securely. See also 
Protocol.

SSL — Secure Socket Layer. A protocol that provides authentication and encryption 
services between a web server and a web browser. See also Protocol.

Streaming Media — Media such as audio, video, and photos that are constantly 
received while being delivered by a streaming provider.

Striping — The spread of data over multiple hard drives to improve performance. 
See also RAID 0.

TCP/IP — Transmission Control Protocol/Internet Protocol. A set of protocols for 
communication over interconnected networks. The standard for data transmission 
over networks. See also Protocol.

TLS — Transport Layer Security. Successor to SSL. See also SSL.
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Two Mirror Mode — Two Mirror mode is available when four drives are installed in a 
device. In this mode, two independent RAID 1 volumes are created.

Twonky Media Server — A server application that searches for all the media (for 
example, videos, photos, and music) stored on the WD ShareSpace connected to 
your home network. 

UPnP — Universal Plug n Play. A set of computer network protocols that simplify the 
implementation of networks in the home by allowing devices to connect seamlessly. 
See also Protocol.

UPnP NAT Traversal — Combines UPnP and NAT features. 

UPS — Uninterruptable Power Supply. A standalone device that provides secondary 
power to connected equipment in the event of a power failure.

USB — Universal Serial Bus. A serial bus for connecting peripherals to a 
microcomputer. It connects external drives, printers, modems, mice, keyboards, etc., 
through a single, general-purpose port. It can automatically add and configure new 
devices without having to shut down and restart the system.

USB 2.0 — For most PCs, the standard interface is USB. Hi-Speed USB (USB 2.0) 
supports data transfer rates up to 480Mb/s. USB 2.0 is backward-compatible with 
USB 1.1. — If you connect to a USB 1.1 device, data is transferred at USB 1.1 
speed (up to 
1.1 Mb/s).

WAN — Wide Area Network. A computer network that crosses metropolitan, 
regional, or national boundaries.

WD Anywhere Backup — WD backup software that allows the user to set up 
continuous backup of all or selected files for up to five computers in a network. This 
feature backs up your data to the WD ShareSpace so you can restore your data in 
the event that a computer’s hard drive crashes. 

WD Discovery™ — WD software application that allows the host computer to find 
one or more WD network storage systems in the same network segment.
GLOSSARY - 163



WD SHARESPACE
USER MANUAL

15
 Appendix

Regulatory Compliance

FCC Class B Information

This device has been tested and found to comply with the limits of a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
unit generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio or 
television reception. However, there is no guarantee that interference will not occur in 
a particular installation. Any changes or modifications not expressly approved by WD 
could void the user's authority to operate this equipment.

The following booklet, prepared by the Federal Communications Commission, may 
be helpful: How to Identify and Resolve Radio/TV Interference Problems. This 
booklet is Stock No. 004-000-00345-4 available from the US Government Printing 
Office, Washington, DC 20402.

The provided Ethernet cable must be used between the unit and network connection 
to comply with FCC Part 15 Class B and EN-55022 Class B.

ICES/NMB-003 Compliance

Cet appareil de la classe B est conforme à la norme NMB-003 du Canada.

This device complies with Canadian ICES-003 Class B.

Safety Compliance

Approved for US and Canada. CAN/CSA-C22.2 No. 60950-1, UL 60950-1: Safety 
of Information Technology Equipment.

Approuvé pour les Etats-Unis et le Canada. CAN/CSA-C22.2 No. 60950-1 : Sûreté 
d'équipement de technologie de l'information.

This product is intended to be supplied by a listed limited power source, double 
insulated, or direct plug-in power unit marked “Class 2.”

CE Compliance for Europe

Verified to comply with EN55022 for RF emission;  EN-55024 for Generic Immunity, 
as applicable; and EN-60950 for Safety.
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Environmental Compliance (China)

Warranty Information

Obtaining Service

WD values your business and always attempts to provide you the very best of 
service. If this Product requires maintenance, either contact the dealer from whom 
you originally purchased the Product or visit our product support website at 
support.wdc.com for information on how to obtain service or a Return Material 
Authorization (RMA). If it is determined that the Product may be defective, you will be 
given an RMA number and instructions for Product return. An unauthorized return 
(i.e., one for which an RMA number has not been issued) will be returned to you at 
your expense. Authorized returns must be shipped in an approved shipping container, 
prepaid and insured, to the address provided on your return paperwork. Your original 
box and packaging materials should be kept for storing or shipping your WD product. 
To conclusively establish the period of warranty, check the warranty expiration (serial 
number required) via support.wdc.com. WD shall have no liability for lost data 
regardless of the cause, recovery of lost data, or data contained in any Product 
placed in its possession.
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Limited Warranty

WD warrants that the Product, in the course of its normal use, will be free from 
defects in material and workmanship for a period of three (3) years, unless otherwise 
required by law, and will conform to WD’s specification therefor. This limited warranty 
period shall commence on the purchase date appearing on your purchase receipt. 
WD shall have no liability for any Product returned if WD determines that the Product 
was stolen from WD or that the asserted defect a) is not present, b) cannot 
reasonably be rectified because of damage occurring before WD receives the 
Product, or c) is attributable to misuse, improper installation, alteration (including 
removing or obliterating labels and opening or removing external enclosures, 
including the mounting frame, unless the product is on the list of limited user-
serviceable products and the specific alteration is within the scope of the applicable 
instructions, as found at support.wdc.com), accident or mishandling while in the 
possession of someone other than WD. Subject to the limitations specified above, 
your sole and exclusive warranty shall be, during the period of warranty specified 
above and at WD’s option, the repair or replacement of the Product. The foregoing 
warranty of WD shall extend to repaired or replaced Products for the balance of the 
applicable period of the original warranty or ninety (90) days from the date of 
shipment of a repaired or replaced Product, whichever is longer.

The foregoing limited warranty is WD’s sole warranty and is applicable only to 
products sold as new. The remedies provided herein are in lieu of a) any and all other 
remedies and warranties, whether expressed, implied or statutory, including but not 
limited to, any implied warranty of merchantability or fitness for a particular purpose, 
and b) any and all obligations and liabilities of WD for damages including, but not 
limited to accidental, consequential, or special damages, or any financial loss, lost 
profits or expenses, or lost data arising out of or in connection with the purchase, 
use, or performance of the Product, even if WD has been advised of the possibility of 
such damages. In the United States, some states do not allow exclusion or limitations 
of incidental or consequential damages, so the limitations above may not apply to 
you. This warranty gives you specific legal rights, and you may also have other rights 
which vary from state to state.

GNU General Public License (“GPL”)

Firmware incorporated into My Book World Edition includes third party copyrighted 
software licensed under the GPL (“GPL Software”). In accordance with the GPL: 1) 
the source code for the GPL Software may be obtained at support.wdc.com/
download/gpl; 2) you may re-use, re-distribute and modify the GPL Software; 3) with 
respect solely to the GPL Software, it is provided “as is” without warranty of any kind, 
either expressed or implied, including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose, to the extent permitted by 
applicable law; and 4) a copy of the GPL is included on the enclosed CD, may be 
obtained at www.gnu.org, and may also be found at support.wdc.com/download/gpl.

When contacting WD for support, have your WD product serial number, system 
hardware, and system software versions available.
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Information furnished by WD is believed to be accurate and reliable; however, no responsibility is assumed by WD for its 
use nor for any infringement of patents or other rights of third parties which may result from its use. No license is granted 
by implication or otherwise under any patent or patent rights of WD. WD reserves the right to change specifications at 
any time without notice.

Western Digital, WD, the WD logo, My Book, WD Caviar and MioNet are registered trademarks in the U.S. and other 
countries; and World Edition, Green, and WD Discovery are trademarks of Western Digital Technologies, Inc. Other 
marks may be mentioned herein that belong to other companies.

© 2009 Western Digital Technologies, Inc. All rights reserved.

4779-705006-A04 April 2009
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